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1 Introduction 
 
This work is a contribution to Nagra's investigations on the long-term landscape evolution of 
Northern Switzerland. It specifically focuses on (GIS-based) mapping and analysis of the spatial 
distribution, controls and effects of hillslope / landslide processes in the Jura Ost siting region, a 
section of the Jura Mountains that is closely linked to the Aare/Rhine drainage system by several 
tributary valleys. The analysis of stream longitudinal profiles along these valleys also represents 
an integral part of the study, to investigate potential dynamics along the fluvial network and their 
effects on (and coupling with) hillslope processes. Overall, the work should form a site-specific, 
qualitative – and partly quantitative – basis for future landscape evolution scenarios (on the 
hillslope scale). 

It is acknowledged, that this is an "as-is state" investigation based on the present state of topo-
graphy that might be transient as a result of the past geological history (see Schnellmann et al. 
2014) and under prevalent interglacial climate conditions. Locally, anthropogenic perturbation 
might bias the analysis, but is generally regarded as negligible, or indicated elsewhere.  

1.1 Motivation 
Future research directions within Nagra's "Research Development and Demonstration plan" 
(Nagra 2016) identified the need for a better understanding of the evolution of local topography 
and associated processes in the Jura Ost siting region. Important topics related to this overall 
objective include: 

• the role of hillslope / landslide processes (and their geological / topographic control) for land-
scape evolution 

• better understanding of the coupling between hillslopes and the fluvial network, particu-
larly hillslope response to base level drop and knickpoint migration 

• consideration of landslides in Opalinus Clay and its covering lithostratigraphic units as one 
possible exposure scenario of the repository at its late stage 

Ideally, a site-specific geomorphic transport law regarding the quantitative contribution of hill-
slope processes to erosion would be expected, which could then be transferred to a predictive 
landscape evolution model. Although this is not achieved by this study, a basis is provided by 
more qualitative considerations and partly supported by quantitative analyses. 

1.2 Detailed objectives 
As already indicated, it is the general aim of this study to extract information from the present-
day landscape, that potentially help to address the topics from section 1.1. The methodological 
approach consists in GIS-based mapping and analysis of digital terrain models (DTM) as well as 
additional spatial data (e.g. geological maps). While some locations have additionally been visited 
and inspected in the field, a solid ground truthing (also concerning the depth of landslides) was 
not part of this study. 

As a basis for the final discussion, the results are illustrated and synthesised by various maps, 
profiles and diagrams. 
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Specifically, the following objectives are pursued: 

Creating a map of (hillslope) process domains 1 across the different lithostrati-
graphic units of the Jura Ost siting region to... 
• visualise the spatial pattern of landslide-affected hillslopes, where have landslides been 

active, where not (yet)? 

• provide an area-covering terrain classification regarding the state of hillslope processes 

• provide a base map for quantitative topographic analyses regarding hillslope processes (see 
below) 

Quantitatively analysing the relationships of the mapping result with topographic 
and lithological variables to…  
• indicate landslide susceptibility of different lithostratigraphic units 

• describe the topographic characteristics of individual landslides (area, internal relief, slope 
gradient and aspect of landslide surface) and their dependence on lithology 

• describe the distribution of hillslope orientations for the different lithostratigraphic units 
(summarised for both failed and unfailed hillslopes) 

Interpreting and characterising different landslide types in the study area to 
indicate… 
• the variety of processes 

• their dependence on the geological and topographic setting (potential causes and control 
mechanisms) 

• implications on affected areas, volumes and rates of movement (qualitative considerations 
only) 

• possible scenarios relevant to landslide-caused exposure of a repository 

Investigating the spatial distribution of hillslope processes with respect to stream 
longitudinal profiles and former base levels of erosion to… 
• identify potential coupling and feedbacks between incision and hillslope processes along the 

fluvial network, particularly hillslope erosion in response to knickpoint migration (if existing) 

• identify landscape sections with different history of fluvial incision 

• infer rough age constraints of possible landslide initiation based on relative comparison of 
landslide elevation and the former base levels 

  

                                                           
1  The map of process domains extends the mapping of landslides by classifying the rest of the terrain as either 

"unfailed hillslopes", "upland low-relief areas" and "Quaternary plains and terraces" (see further explanations in 
section 3.2).  
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1.3 Report structure 
Following this introduction, Chapter 2 contains additional background on the geographic and 
geological setting as well as references to related investigations from the study area. 

Section 3.1 gives an overview of the input datasets of this study and which GIS-based tasks they 
were used for. Sections 3.2 to 3.7 describe the individual tasks more extensively. 

Section 4.1 discusses the results of mapping landslides and (hillslope) process domains. This is 
largely based on illustrations (map, diagrams, profiles) in Appendix 1, 2 and 4. The section also 
addresses the question of the topographic / geological controls on landslide / hillslope processes 
and geometry.  

Specific landslide types of the study area are interpreted and characterised in section 4.2.  

The third part of the discussion deals with the stream analysis (section 4.3). Here, similarities and 
differences of stream longitudinal profiles in the study region are discussed and analysed with 
respect to potential dynamics of fluvial incision in the present landscape. Also, possible relations 
to the observed pattern of hillslope / landslide processes are addressed. 

Chapter 5 summarises the conclusions from this study. It relates to the initial motivation in 
section 1.1. 
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2 Study Area and Related Studies 
 
The Jura Ost siting region represents one of three areas in Northern Switzerland, that are currently 
investigated by Nagra as potential locations for the deep geological disposal of radioactive waste 
(e.g. Nagra 2014a). As implied by the name, the area is located in the eastern part of the Jura 
Mountains, a mountain range in the Alpine foreland that is well explored by geological research 
(e.g. Becker 2000, Madritsch et al. 2008).  

Within the Jura Mountains, the siting region is assigned to the tectonic regime of the "Deformed 
Tabular Jura", representing a transition zone between the "Tabular Jura" in the north and the 
"Folded Jura" in the south (Fig. 1; Madritsch 2015). The study area is characterised by few 
tectonic structures, the most prominent one being the "Mandach thrust fault" north of the siting 
region. Bedding planes within the Deformed Tabular Jura (and the Tabular Jura north of the 
Mandach thrust fault) are mostly flat or gently dipping southward (Nagra 2014a). The regional 
profiles in Appendix 4 indicate the subsurface orientation of thrust faults and lithostratigraphic 
boundaries. 

As shown by the lithostratigraphic column in Fig. 2, the study area includes various (sedimentary) 
lithostratigraphic units2, featuring different petrographic and geomechanical properties (Tab. 1). 
These variations suggest a controlling effect on terrain processes and morphology, which is of 
importance for the present study. As an example, Tab. 1 lists rock strength as a rough indicator 
for the resistance of each lithostratigraphic unit to erosion (e.g. Bursztyn et al. 2015). 

With respect to landscape evolution, recent studies have extensively investigated the history of 
fluvial and glacial erosion and the reorganisation of drainage systems in Northern Switzerland 
over the last few million years (Ziegler & Fraefel 2009, Preusser et al. 2011, Yanites et al. 2013, 
Heuberger & Naef 2014, Heuberger et al. 2014). A regional elevation model of the bedrock sur-
face, resulting from this complex geological history, was compiled by Pietsch & Jordan (2014). 
Results from these and other important studies related to the landscape evolution in Northern 
Switzerland are summarised in Schnellmann et al. (2014). While mostly looking at a larger 
regional (and temporal) scale, these previous studies build an important framework for studying 
the local topography in the Jura Ost siting region. Also, they have provided a basis to set up a 
numerical landscape evolution model for the eastern Jura Mountains (Yanites et al. 2017). 

Present-day terrain elevation within the extended study area ranges from around 700 m a.s.l. at 
the highest hilltops of the Deformed Tabular Jura (Schinberg, Geissberg; Fig. 1) to 300 m a.s.l. at 
the outlet of the Sissle river into the Rhine. Given this local relief, hillslope processes play a 
relevant role in shaping the landscape of the Jura Ost siting region and its surrounding areas. For 
instance, historic landslides from the study area have been documented by Baltzer (1876), 
Hartmann (1928, 1950) and Haefeli (1940). These examples and other landslide-related features 
can be further identified in the Geological Atlas of Switzerland 1:25'000 (© swisstopo). To 
account for such processes, the numerical landscape evolution model by Yanites et al. (2017) uses 
a "hillslope erodibility" parameter to model hillslope erosion as a function of slope gradient and 
(optionally) rock type. In this case, hillslope erosion is treated as a diffusive process and erodibi-
lity is calibrated based on topographic metrics of the present-day landscape (e.g. distribution of 
hillslope gradients) at a spatial resolution of 250 m. 
  

                                                           
2  If names of lithostratigraphic units include the term "formation", this report uses the German notation with a 

hyphen, e.g. "Villigen-Formation" instead of "Villigen Formation" (except in Fig. 2). 
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Fig. 1: Tectonic and geographical setting of the Jura Ost siting region (modified from 
Madritsch 2015). 
The siting region is part of the Deformed Tabular Jura, which is confined by the "Mandach 
thrust fault" (MA) to the north and the "Jura main thrust" (J) to the south. Appendices 1.A, B 
and C contain additional maps with more detailed geographical and geological information. 
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Fig. 2: Lithostratigraphic column of the Jura Ost siting region (modified from Nagra 2008). 
Malm = Upper Jurassic; Dogger = Middle Jurassic; Lias = Lower Jurassic; Keuper and 
Muschelkalk = Triassic. See Nagra (2014a) for more detailed explanations on lithostrati-
graphic units. 
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Tab. 1: Characteristics of lithostratigraphic units of the study area. 
Lithologic descriptions are based on Biaggi et al. (2014), Enclosure 8 ("Zugangsbauwerk 
(Schacht) repräsentativ für Schachtstandorte JO-3+, Geologisches Profil Jura Ost mit Daten-
bändern nach SIA 199"). Data on rock strength correspond to Appendix A4 from the same 
report, representing estimates of uniaxial compressive strength of intact rock. While litho-
logic descriptions and rock strength specifically refer to the Jura Ost siting region (Biaggi et 
al. 2014), the mean content of clay minerals is based on general observations for Nagra's 
siting regions in Northern Switzerland (Nagra 2014b). Numbers in brackets indicate typical 
ranges. The lithostratigraphic units Hauptrogenstein and Klingnau-Formation represent dif-
ferent facies types of comparable stratigraphic age (see Fig. 2), with the former dominating 
in the western and the latter dominating in the eastern part of the study area (see Nagra 
2014a). 

 

Name Lithologic description Mean content 
of clay minerals 

[%] 

Rock  
strength 

[MPa] 

Tertiary sediments 
(Molasse) 

Marls, sandstones, conglomerates not listed not listed 

Villigen-Formation Hard limestones, few thin marly 
layers not listed 100 

(100 – 200) 

Wildegg-Formation Calcareous marls [a], some 
limestone sequences [b] 

27 (20 – 40) [a] 
12 (0 – 20) [b] 

30 
(10 – 60) 

Ifenthal-Formation Limestones, sand marls not listed 30 
(1 – 105) 

Hauptrogenstein Oolitic limestones, with thin marly 
layers not listed 

30 
(14 – 140) Klingnau-Formation Marls and argillaceous limestones not listed 

Passwang-Formation Cyclic sequence of claystones [c], 
sand marls [c] and limestones [d] 

46 (20 – 65) [c] 
11 (5 – 15) [d] 

50 
(40 – 120) 

Opalinus Clay Claystones  60  
(40 – 75) 

15 
(4 – 30) 
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3 Data and Methods 
 
The present GIS-based analysis involves the processing of many existing datasets, which will be 
introduced in section 3.1. The subsequent sections outline the methodological approach of the 
different tasks, as follows: 

• Manual mapping of landslides and process domains (section 3.2) 

• Quantitative synthesis of landslides and map of process domains (section 3.3) 

• Intersecting former base levels of erosion with present topography (section 3.4) 

• Extracting stream longitudinal profiles (section 3.5) 

• Extracting topographic / geological profiles (section 3.6) 

• Calculating topographic parameters for (additional) map representations (section 3.7) 

These sections provide an overview of the methodological approach and outline the working 
steps. More detailed information concerning datasets and the technical procedure in ArcGIS are 
shown in Appendix 5 and Appendix 6, respectively. 

3.1 Input datasets 
Fig. 3 provides an overview of the various input datasets and indicates the GIS-based tasks they 
are used for.  

All these datasets are either publicly available from swisstopo or based on previous investigations 
by Nagra. The names of the datasets listed in Fig. 3 are used as references throughout this report, 
which should improve the readability in contrast to using filenames. A detailed list with links to 
filenames, sources and supplementary information on the datasets can be found in Appendix 5. 

Sections 3.2 to 3.7 include further information on the datasets, where relevant to the approach and 
to the final interpretation of the results (Chapter 4). 
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Fig. 3: Input datasets (white boxes) directly or indirectly used for GIS-based tasks (grey 
boxes). 
These datasets are also partly used for map representations in Appendix 1. 

 
 

Section 3.2
 
  

Section 3.4 

Section 3.3 

Section 3.7 

Section 3.5 Section 3.6 
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3.2 Manual mapping of landslides and (hillslope) process domains 
As outlined in section 1.2, an area-covering classification of the terrain with regard to landslides 
and (hillslope) process domains across the Jura Ost siting region is targeted. For this purpose, the 
time-consuming task of manual landslide mapping was necessary, due to the lack of an adequate 
dataset in this region (i.e. landslide inventory or natural hazard map3). Slope instabilities 
("Rutschmasse", "Sackungsmasse") are partly indicated in the Geological Atlas of Switzerland 
1:25'000 (© swisstopo). However, visual comparison of its digitised version 'GeoCover' with the 
DTM-AV hillshade (© swisstopo) reveals some problems for the present study (Fig. 4): 

• Instead of landslides being mapped as contiguous polygons, they are typically represented by 
a combination of line objects (e.g. scarps, counterscarps) and smaller (isolated) polygon 
objects. Therefore, only parts of the landslide surface are mapped as such. 

• The coarser scale of the Geological Atlas of Switzerland 1:25'000 sometimes produces devia-
tions of mapped elements when compared to the 2 m-resolution DTM-AV, used for quanti-
tative topographic analyses in this study. 

For the present investigation, more complete mapping is therefore required. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. 4: Exemplary comparison of landslide-related map elements of the digitised Swiss 
Geological Atlas 1:25'000 (GeoCover) and the interpreted landslide extent (this 
study) based on visual interpretation of the DTM-AV. 

 
  

                                                           
3  Unlike other cantons, the Canton of Aargau has not published a natural hazard map ("Gefahrenkarte") concerning 

slope instabilities to this date. 
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3.2.1 Classification scheme and definitions 
Fig. 5 shows the classification scheme representing the map of (hillslope) process domains. Apart 
from providing a visual impression of spatial patterns, the resulting map should allow for different 
area-based quantitative analyses. 

 
 
 
 
 
 
 
 
 
 
 
 

Fig. 5: Classification scheme for mapping of process domains. 
 
The first splitting between "hillslopes" and "non-hillslopes", obviously separates segments poten-
tially affected by hillslope / landslide processes from flatter areas, dominated by alternative geo-
morphologic processes (e.g. fluvial processes). The subsequent division within the "non-hill-
slopes" domain indicates, which areas rather correspond to accumulative domains below 
hillslopes ("Quaternary plains and terraces") vs. more bedrock-dominated and till-covered 
plateaus above hillslopes ("upland low-relief areas"), which may be eroded by future hillslope 
processes, once the latter approach these areas. 

Within the "hillslopes" domain, the actual landslide mapping is executed. In analogy to recom-
mendations by former agencies of the Swiss Federal Office for the Environment ("Symbolbau-
kasten zur Kartierung der Phänomene"; BWG / BUWAL 1995), the hillslope domain is sub-
divided into three classes (Tab. 2). 

Tab. 2: Subclasses of the hillslope domain in this study and analogy to the "Symbolbau-
kasten zur Kartierung der Phänomene" (BWG / BUWAL 1995). 

 

This study "Symbolbaukasten zur Kartierung der 
Phänomene" (BWG / BUWAL 1995) 

"Presumably unfailed hillslopes" ~ "potentieller Prozess" 4 

"Presumed landslides" ~ "vermuteter Prozess" 5 

"Evident landslides" ~ "erwiesener Prozess" 

                                                           
4  "Prozess, der an der betreffenden Stelle nicht gewirkt hat, der jedoch aufgrund der allgemeinen Konstellation 

(Topographie, Geologie, Hydrologie, Vegetation, Waldzustand, Bauten usw.) eintreten könnte" (BWG / BUWAL 
1995, p. 18). 

5  "Prozess, der an der betreffenden Stelle nicht mit Sicherheit erwiesenermassen gewirkt hat, der jedoch beispiels-
weise aufgrund schwer interpretierbarer Hinweise im Gelände, von vagen Aussagen, aufgrund von allgemeiner 
Erfahrung oder von Analogieschlüssen (Vergleich von vergleichbaren anderen Gefahrengebieten) gewirkt haben 
dürfte" (BWG / BUWAL 1995, p. 18). 
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The intermediate category of "presumed landslides" accounts for the uncertainty inherent to land-
slide mapping (e.g. Van den Eeckhaut et al. 2007). More details on the distinction of the different 
categories in the mapping procedure are given in section 3.2.2. 

Landslides are here deliberately understood in a broad sense as hillslope processes which include 
gravity driven mass movements of semi-coherent masses. This basically involves the various 
landslide types according to Hungr et al. (2014), as listed in Tab. 3. However, some comments 
are required for clarification: 

• The differentiation of landslide types is desired. However, this is not applicable in a systema-
tic way for the (remote) mapping approach of the present study. To this end, more information 
for characterisation of individual landslides (e.g. knowledge from site-specific geological 
investigations, deformation measurements) would be needed than is provided by the available 
datasets (DTM derivatives, GeoCover, orthophotos). As pointed out in section 1.2, an attempt 
will however be made, to identify important landslide types in the study area and to describe 
them for suitable examples. 

• The mapping is restricted to landslides of movement types "topple", "slide", "spread", "flow" 
and "slope deformation" according to Tab. 3. This implies that rock fall (type "fall") is not 
represented by the resulting map. The focus is put on the other movement types for the 
following reasons: i) they are usually identifiable as contiguous (extensive) landslides 
(instead of more discrete rock fall events, difficult to localise in the available datasets6); ii) in 
contrast to source areas of rock fall being usually located along the edge of plateaus, the other 
landslide types are often directly connected to the valley floor. Therefore, they are more of 
interest with respect to interpreting the coupling of hillslope processes and fluvial incision 
(while rock fall is more likely to have an indirect response, being interconnected with the 
fluvial system by other landslide processes at lower/intermediate hillslope sections). Still, 
rock fall is relevant to some lithostratigraphic units and will therefore be addressed again 
briefly in the discussion of section 4.2. 

"Shallow" vs. "deep-seated" landslides 
In agreement with BWG / BUWAL (1995) the term "deep-seated" ("tiefgründig") is here applied 
to landslides with a depth of movement > 10 m (up to several decameters). This is mostly assumed 
for large landslides, where high head scarps or large internal deformation features suggest a cor-
responding depth of (internal) deformation. 

As opposed to this, "shallow landslides" here correspond to landslides with a depth of movement 
assumed to be less than 10 m ("flachgründig" or "mittelgründig" according to BWG / BUWAL 
1995). 

  

                                                           
6  DTM hillshades and orthophotos showing mostly forested hillslopes. 
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Tab. 3: Classification system of landslide types by Hungr et al. (2014).  
The words in italic are placeholders, indicating different material types that may be involved 
in the process.  

 

Type of movement Rock Soil 

Fall 1. Rock/ice fall 2. Boulder/debris/silt fall 

Topple  3. Rock block topple 

4. Rock flexural topple 

5. Gravel/sand/silt topple 

Slide 6. Rock rotational slide 

7. Rock planar slide 

8. Rock wedge slide 

9. Rock compound slide 

10. Rock irregular slide 

11. Clay/silt rotational slide 

12. Clay/silt planar slide 

13. Gravel/sand/debris slide 

14. Clay/silt compound slide 

Spread 15. Rock slope spread 16. Sand/silt liquefaction spread 

17. Sensitive clay spread 

Flow 18. Rock/ice avalanche 19. Sand/silt/debris dry flow 

20. Sand/silt/debris flowslide 

21. Sensitive clay flowslide  

22. Debris flow 

23. Mud flow 

24. Debris flood 

25. Debris avalanche 

26. Earthflow 

27. Peat flow 

Slope deformation 28. Mountain slope deformation 

29. Rock slope deformation 

30. Soil slope deformation 

31. Soil creep 

32. Solifluction 

 
 

3.2.2 Mapping procedure and criteria 
The extent of process domain mapping is roughly confined by the Mandach thrust fault in the 
north, the Sissle river in the southwest and the Aare river in the south and east (Fig. 1 and 
Appendix 1.A). Thus, the classification covers all major lithostratigraphic units of the Jura Ost 
siting region and includes the upper reaches of local tributaries to the Aare and Rhine rivers.  
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The mapping was executed manually in ArcGIS at a map scale of ~ 1:2'000, based on visual 
inspection of the following datasets (Appendix 5.A): 

• DTM-AV hillshade7 

• DTM Jura Ost hillshade 

• DTM-AV slope gradient map 

• GeoCover (Geological Atlas of Switzerland 1:25'000) 

• Topographic map (1:25'000) 

• Orthophotos 

Individual terrain segments were manually mapped and labelled according to the classification 
scheme of Fig. 5. 

"Hillslopes" and "non-hillslopes" were roughly differentiated based on the pixel-based slope 
gradient map of DTM-AV. As a rule of thumb, the mapped "non-hillslopes" are equivalent to 
larger terrain segments, where slope gradients are fairly homogenous and mostly < 7°. This 
threshold is set rather low, in agreement with some known landslides in the surrounding area, that 
at least in some parts also show such low hillslope angles (Hartmann 1928). The distinction of 
"Quaternary plains and terraces" vs. "upland low-relief areas" was then made based on the relative 
position of the terrain segment with respect to hillslopes (below vs. above) and information from 
the GeoCover dataset (e.g. alluvial deposits). 

Within the "hillslope domain", segments were differentiated according to the terms introduced in 
Fig 5. Fig. 6 contains examples to illustrate, how the different classes are assigned to the terrain, 
depending on the contextual information gathered from the different base maps. 

It must be noted, that there is no completely objective set of rules available for the displayed 
segmentation and classification of hillslopes. Similarly, attempts of automated landslide mapping, 
e.g. using quantitative thresholds related to surface roughness or machine learning algorithms, are 
also subject to misclassifications (e.g. McKean & Roering 2004, Van den Eeckhaut et al. 2012), 
particularly if considering the variety of processes and lithological substrates of the study area. 

  

                                                           
7  Hillshades were calculated and used for the mapping at azimuth angle of the light source of 45°, 135°, 225° and 

315°, respectively. 
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Fig. 6: Local examples of landslide / (hillslope) process domain mapping using contextual 
criteria from different base maps. 
The column headers refer to the different base maps displayed in each column. Black or red 
outlines show segment boundaries from the mapping of landslide segments. Colours in the 
left-hand column indicate process domains as follows (see also Appendix 1.C for 
comparison): green = "Quaternary plains and terraces"; brown = "upland low-relief areas"; 
yellow = "presumably unfailed hillslopes"; orange = "presumed landslides"; red = "evident 
landslides". Black arrows in the left-hand column indicate mean slope aspect of landslide 
surfaces. Colours in the slope gradient map indicate steeper (red) vs. flatter (green) terrrain 
sections. For explanation on the letters displayed in the slope gradient map ('h', 'r', 'l' etc.), 
see corresponding text sections of this report. 
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Some guidelines for the present mapping, however, are listed below and explained with reference 
to Fig. 6. Letters in brackets will refer to characteristic locations in Fig. 6: 

• Key features used to identify landslides include distinctive head scarps ('h'), high surface 
roughness8 ('r') or "toe bulging" ('b'). Where such features are well expressed, landsliding is 
usually also indicated in the GeoCover dataset, except for relatively small landslides 
(< ~ 0.03 km2). Terrain sections will be mapped as "evident landslides", if two (typically 'h' 
and 'r') or all three criteria are well expressed and allow for a clear definition of the landslide's 
spatial extent. 

• The class "presumed landslide" is chosen instead, where some of these features occur, but 
rather as isolated phenomena ('I'), less distinctly ('l') or modified by superimposing effects 
(anthropogenic effects 'a' or different geomorphological processes such as gully erosion 'g'). 
In contrast to segments of "evident landslides", the class "presumed landslide" is usually 
characterised by less discernible boundaries. 

• The adjacency to streams can also increase the probability of landsliding by toe erosion. For 
this reason, small and steep segments of high surface roughness along stream channels are 
mapped as "evident landslides" ('ch'), even though other key features may not be recognisable 
due to their small size. 

• Additionally, topological relations ('t') are accounted for. For instance, if a terrain segment 
immediately above a landslide segment indicates weak signals of slope movement (e.g. 
slightly increased surface roughness), this can be related to the main landslide activity on the 
downhill side. Therefore, such a segment is classified as "presumed landslide", while it might 
have been classified as "presumably unfailed hillslope" in another context (i.e. in the absence 
of an "adjacent landslide"). These "presumed landslide" sections are usually small relative to 
the main landslide segment. 

• The "presumably unfailed hillslope" class is typically represented by smoother hillslopes, 
without distinct key features as described above. Surface roughness within this domain can 
locally be increased due to anthropogenic effects (e.g. road cuts or quarries) or features of 
fluvial erosion. Orthophotos and the topographic map have been used to prevent such features 
to be interpreted as landslide-related. 

These considerations demonstrate that the mapping result will be affected by some subjectivity 
and potentially some misclassifications. The class "presumably unfailed hillslope" may contain 
landslide-affected sections, where these have not been recognised, e.g. in case of shallow and 
slow movement with little deformation or in case of old (inactive) landslides, "overprinted" by 
other surface processes. However, it can be assumed that many landslides and process domains 
are correctly identified. 

  

                                                           
8  Increased surface roughness is attributed to internal deformation of the landslide mass, often expressed by scarps, 

trenches, benches and counterscarps / reverse scarps (e.g. Hungr et al. 2014). Larger structures of these types are 
usually indicated in the GeoCover dataset (see also Fig. 4). Besides, such features (and increased surface roughness 
in general) are expressed in the hillshade view and slope gradient map by high heterogeneity of slope gradients. 



NAGRA NAB 17-42 18  

3.3 Quantitative synthesis of landslides and map of (hillslope) process 
domains 

The mapping results have been quantitatively analysed in different ways to support final dis-
cussions with respect to the objectives of Chapter 1. The resulting diagrams can be considered as 
a synthesis that complements the map representations. The analysis includes: 

• Calculation of areal proportion of each process domain intersecting with a lithostratigraphic 
unit: This should indicate, whether certain lithostratigraphic units within the study area are 
rather dominated by the "hillslope" vs. "non-hillslope" domain and to what degree hillslopes 
tend to be landslide-affected (~ "landslide susceptibility" of lithostratigraphic units). 

• Distribution of pixel-based slope orientation within hillslope domain, separated for different 
lithostratigraphic units: This should indicate the dependence of slope gradients on lithology 
and slope aspect. Additionally, it forms a reference frame for analysing slope orientations of 
landslide surfaces. 

• Calculation of surface characteristics of individual landslides / landslide complexes: This 
includes topographic characteristics (area, mean slope orientation (gradient and aspect) and 
internal relief) and the lithostratigraphic composition, which should help to identify topo-
graphic and lithological controls on landslides. 

The next sections will give an overview, how these tasks were executed. Detailed descriptions of 
the processing in ArcGIS are shown in Appendix 6 (section A).  

3.3.1 Areal proportion of process domains within lithostratigraphic units 
To calculate the areal proportion of different process domains within separate lithostratigraphic 
units, the "Zonal Histogram" tool in ArcGIS was used. As input for this, two raster datasets, 
representing both the process domains and lithostratigraphic domains, were required. The spatial 
resolution was defined at a grid size of 2 m. The "process domains (raster)" were simply created 
by converting the "process domains" resulting from section 3.2. 

The raster representing the lithostratigraphic domains was created from a polyline dataset ("litho-
stratigraphic boundaries"), that in turn was manually extracted and partly interpolated from the 
Geological Atlas of Switzerland 1:25'000 and expert knowledge of the local geology (provided 
to Nagra by P. Jordan / Gruner Böhringer AG, Oberwil). These "lithostratigraphic boundaries" 
are displayed in the map representation of Appendix 1.C and basically allow for separation of the 
lithostratigraphic units according to Tab. 1 (Chapter 2). The lithostratigraphic units Hauptrogen-
stein (west) and Klingnau-Formation (east) are aggregated in this dataset, as they represent 
different facies types of the same (or similar) stratigraphic age (Nagra 2014a), which are separated 
by a diffuse boundary along the geographical axis Gansingen – Schinznach (see Appendix 1.A 
for geographical locations). 

While this represents the most reliable dataset available to this task, it remains an approximation 
of the true spatial extent of lithostratigraphic domains where bedrock outcrops are sparse. More-
over, it is important to note, that in areas covered by Quaternary deposits (see Appendix 1.B for 
spatial distribution), the lithostratigraphic boundaries are projected to the surface along the orien-
tation of bedding planes at depth. This can produce horizontal offsets of surface boundaries with 
respect to top bedrock, as a function of the thickness of Quaternary deposits and the angle of 
projection. However, in most parts of the study area and particularly within the hillslope domain, 
Quaternary cover is shallow and therefore the dataset was used without further adjustment. 
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As an intermediate step of creating the "lithostratigraphic domains (raster)", the polylines had to 
be converted to polygons, which involved additional processing: 

• Completion of polylines in two cases: i) the dataset "lithostratigraphic boundaries" (as dis-
played in Appendix 1.C) locally contains spatial gaps of a few meters between line elements 
marking the same lithostratigraphic boundary. These were connected linearly; ii) along the 
northern boundary of the mapping area, a more complex tectonic setting is observed, with 
lithostratigraphic boundaries being sometimes interrupted by intersection with tectonic linea-
ments (see Appendices 1.B and 1.C). Here, polylines representing boundaries of the same 
lithostratigraphic units were manually connected along these tectonic lineaments. The 
GeoCover dataset was used to verify, that different lithostratigraphic domains are correctly 
separated by the completed polylines. 

• The resulting dataset "lithostratigraphic boundaries (completed)" was then intersected with a 
polygon that defines the "extent of process domain mapping". 

The result is a polygon dataset which defines the different "lithostratigraphic domains". Since the 
dataset of "lithostratigraphic boundaries" in some cases did not allow a reliable separation of Lias 
(Lower Jurassic) and Triassic sediments in the most northern (tectonically more complex) region 
of the mapping area, these are partly summarised in an additional domain classified as "not dif-
ferentiated". Analogously to the "process domains", the polygon dataset "lithostratigraphic 
domains" had to be converted to a raster dataset, "lithostratigraphic domains (raster)". 

Once the two raster datasets of "process domains (raster)" and "lithostratigraphic domains 
(raster)" were created, the "Zonal Histogram" tool in ArcGIS allowed calculating a histogram, 
which shows the areal proportion of each process domain within each lithostratigraphic unit. 

These areal proportions were finally illustrated in Adobe Illustrator (see Appendix 2 for graphical 
illustration). 

3.3.2 Distribution of pixel-based slope orientation within the hillslope domain 
The datasets of "process domains" and "lithostratigraphic domains" described in the previous 
section were also used to analyse the distribution of pixel-based slope orientation within the hill-
slope domain. Again, the calculations were made separately for the different lithostratigraphic 
domains. 

The analysis was based on derivatives of DTM-AV at a grid size of 2 m. To represent slope 
orientation, three raster datasets were calculated which store the x-, y- and z-components of local 
normal vectors on terrain surface (Fig. 7), respectively. These were derived from pixel-wise 
calculations of slope gradient and slope aspect and transformation by trigonometric functions. 

To reduce the vast number of data points resulting from the high resolution, a point feature class 
was created, to subsample only every tenth raster cell in both east – west and north – south direc-
tion. This point spacing of 20 m was deemed acceptable, given the spatial correlation of slope 
orientation observed for the terrain on short distances. The mask of sampling points was inter-
sected with the polygons of the hillslope domain. The resulting "hillslope sampling points (20 m 
grid spacing)" were then used to extract the x- and -y components of local normal vectors on 
terrain surface together with the corresponding lithostratigraphic domain. 
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Fig. 7: Representation of slope orientation by local normal vectors on terrain surface (from 
McKean & Roering 2004). 
Note that in the present study, the DTM-AV represents the surface as square cells instead of 
the depicted triangular elements. 

 
Finally, based on their x- and y-components, data points were projected on a radial diagram, 
where slope gradients are indicated along the radial axis and slope aspect is represented by the 
azimuth direction. Filtering of the data points is possible by lithostratigraphic units (domains), 
which were previously assigned to the attribute table (see above). 

For final illustration, points have been counted within subsections of the radial diagram (regularly 
divided by intervals of slope gradients (5°) and aspect (22.5°)). This allowed for displaying the 
frequencies of slope orientations for given lithostratigraphic units intersecting with the hillslope 
domain (see Appendix 2 for graphical results). 

3.3.3 Surface characteristics of individual landslides / landslide complexes 
Although the map of process domains indicates the spatial distribution of landslide-affected hill-
slopes, it does not necessarily delineate individual landslides. Instead, landslide-affected hill-
slopes in the study area often extend seamlessly over adjacent valley flanks with changing aspect. 
Also, individual landslides (complexes) are sometimes mapped by several segments that represent 
different degrees of evidence (see Fig. 6 and rest of section 3.2.2).  

An attempt is therefore made, to separate individual landslides / landslide complexes within the 
map of process domains. The basic idea is to aggregate adjacent segments of the classes "evident 
landslides" and "presumed landslides", if their deformation likely occurs interdependently. This 
applies to: 

• Adjacent segments with similar direction of movement (as inferred from slope orientation), 
unless they are separated by distinct topographical dissection (e.g. deeply incised gully) and 
are characterised by a different morphological expression. 

• Adjacent segments with different direction of movement, if the deviating segment is very 
small in comparison to the rest of the landslide and likely to be related (e.g. based on the 
morphological expression). 

Landslide segments are not aggregated if their slope orientation strongly deviates, e.g. in case of 
landslides on opposite hillslopes of a channel or in case of separation by a ridge. 

These criteria are ambiguous in some cases. Thus, there is some subjectivity involved in this 
processing step, too. It is also acknowledged that by the aggregation procedure, superimposing 
processes may be summarised in one individual landslide / landslide complex (e.g. slow deep-
seated processes with more rapid surficial processes; see more on this in section 4.2). 
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Once individual landslides have been merged (and converted into a raster dataset), their surface 
characteristics can be calculated from other raster datasets: 

• DTM-AV 

• Raster datasets representing the x-, y- and z-components of local normal vectors on terrain 
surface (see section 3.3.2) 

• Raster dataset representing the lithostratigraphic domains (see section 3.3.1) 

This is done with the "Zonal Statistics" and "Zonal Histogram" tools in ArcGIS in the following 
way: 

• Calculating internal relief, i.e. maximum elevation difference across landslide surface, by 
"Zonal Statistics" (statistics type "RANGE" applied to DTM-AV) 

• Calculating the normal vector representing the mean orientation of the landslide surface by 
"Zonal Statistics" (statistics type "MEAN" applied to raster datasets representing x-, y- and 
z-components of pixel-based normal vectors) 

• Calculating the areal proportion of different lithostratigraphic units intersecting with the land-
slide surface, by "Zonal Histogram" (based on raster dataset of lithostratigraphic domains, 
section 3.3.1) 

• Creating a point feature class, representing the centroids of the individual landslides / land-
slide complexes 

• Adding the topographic and lithostratigraphic parameters calculated above to the attribute 
table of the landslide centroids 

• Calculating mean slope gradient and mean slope aspect of landslide surface from the mean 
normal vector's components (by using trigonometric functions in the attribute table of the 
"landslide centroids" point feature class) 

These attributes are finally illustrated by ArcGIS and Adobe Illustrator in the following ways (see 
Appendices 1.E, 1.F and 2 for graphical results): 

• Arrows on landslide maps, indicating the mean aspect direction of the landslide surface, and 
being labelled with the mean slope gradient and internal relief 

• Diagrams with pie chart representations of landslides intersecting with specific lithostrati-
graphic units, where: i) size of pie chart indicates landslide area; ii) segments of pie charts 
indicate areal proportion of different lithostratigraphic units intersecting with the landslide 
surface; iii) position of pie chart in diagrams represents topographic variables of landslide 
surface (slope gradient, slope aspect or internal relief; see Appendix 2 for illustration)  
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3.4 Intersecting former base levels of erosion with present topography 
The aim of this processing step is to indicate a simplified minimum terrain elevation at the time 
of the former base levels "Höhere Deckenschotter" (HDS)9 and "Tiefere Deckenschotter" 
(TDS)10. This information can potentially be used: 

• to interpret present stream longitudinal profiles (section 3.5) 

• to identify younger vs. (possibly) older landscape segments 

• to temporally constrain the initiation of mapped landslides 

The two input datasets "base level of HDS" and "base level of TDS" (Heuberger & Naef 2014) 
represent regionally interpolated (nearly planar) surfaces. These interpolations are geometrically 
correct, but hypothetical in the physical sense. The base levels are best constrained by deposits of 
HDS and TDS near the Aare and Rhine river. However, they tend to get poorly constrained 
towards the upper reaches of tributary valleys, or in other words, towards the interior of the study 
area. Also, it must be considered, that in some locations the paleo-topography of the bedrock 
surface may already have been lower than these interpolated surfaces (in case of pre-existing local 
troughs or valley structures). 

The regionally interpolated (base level) surfaces technically "undercut" the present topography, 
where the latter is higher. While this represents a real situation in regions presently covered by 
the corresponding Quaternary deposit (e.g. HDS), such "undercutting" surfaces are of course only 
theoretical in the absence of these deposits.  

Therefore, new raster datasets have been created, where these "undercutting" surfaces are exclu-
ded in the absence of HDS or TDS deposits, respectively. This is done by intersecting the input 
raster datasets "base level of HDS" and "base level of TDS" with the digital terrain model DHM25 
(© Swisstopo) and by taking into account the extent of HDS and TDS deposits from the 
"Quaternary map" (Heuberger et al. 2014). For illustration purposes, the resulting raster datasets 
are finally converted into polygon feature classes. On the map (Appendix 1.D), these polygon 
feature classes display the intersection of the projected base levels of HDS and TDS with present 
topography (DHM25). The details of the procedure in ArcGIS are explained in Appendix 6 
(section B). 

  

                                                           
9  "Höhere Deckenschotter" (HDS): Early Pleistocene (predominantly glaciofluvial) deposits; approximately 2.5 to 

1.8 million years old (Schnellmann et al. 2014). 
10  "Tiefere Deckenschotter" (TDS): Early Pleistocene (predominantly glaciofluvial) deposits; approximately 1.2 to 

0.8 million years old (Schnellmann et al. 2014). 
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3.5 Stream longitudinal profiles 
In a steady-state landscape, where the fluvial system is considered to have fully adjusted to the 
history of tectonic uplift and erosion (and provided substrate resistance is homogeneous), stream 
longitudinal profiles are expected to follow the rule of the "graded river" concept (e.g. Kirby & 
Whipple 2012). According to this, streams show a graded (concave upwards) longitudinal profile, 
with the stream gradient gradually decreasing from the headwater towards the base level. This 
gradual decrease of stream gradient relates to the fact, that with increasing drainage area, the 
stream provides still enough discharge to remove the available bedload even at lower stream gra-
dients. 

Deviations from such graded stream longitudinal profiles may be observed as (convex) anomalies 
or knickpoints, potentially indicating transient signals of base level change / incision within a 
drainage system (as opposed to the steady state). The analysis of stream longitudinal profiles will 
therefore be of interest in the attempt to identify stream sections with different history of fluvial 
incision11 and to study associated effects on hillslope processes (as inferred from the landslide 
mapping). 

Stream longitudinal profiles have been extracted for 15 tributaries to the Aare and Rhine with 
headwaters in the Jura Ost siting region (Fig. 8 and Appendix 1.G). Apart from the present topo-
graphy (DTM-AV), the resulting profiles (Appendix 3) display the following information: 

• Base level of HDS (section 3.4) 

• Base level of TDS (section 3.4) 

• Top bedrock (where Quaternary deposits > 5 m) 

• Lithostratigraphic units of bedrock surface 

These illustrations aim at addressing the following questions: 

• Are there any knickpoints / anomalies in the present topographic profile? 

• If so, how can they be interpreted? For instance, a) are they associated with lithological 
variations along the stream, b) can they be related to former base levels of erosion?  

The next sections (3.5.1 and 3.5.2) will outline the approach of profile extraction and editing. The 
detailed working steps in ArcGIS are again explained in Appendix 6 (section C). The final section 
(3.5.3) explains the approach and concepts of how knickpoints / anomalies have been interpreted 
in the context of the "graded river" concept introduced above.  

3.5.1 Selection of stream courses 
For extraction of stream longitudinal profiles, stream courses have been selected from the input 
dataset "drainage network TLM" (Fig. 8). These data are part of the Topographic Landscape 
Model 'TLM' by swisstopo, where streams are mapped as polylines according to their present 
course. These present stream courses may be anthropogenically altered locally. However, in con-
trast to drainage networks calculated from high-resolution DTMs, they are not subject to artefacts 
like artificial deflections of stream courses by road embankments and are therefore considered 
more appropriate for the present analysis. 

                                                           
11  a) Incised sections below knickpoints; b) locations of present knickpoint migration; c) "Perched low-relief land-

scapes" above knickpoints. 
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In some cases, the polylines of the "drainage network TLM" had to be extended manually for the 
headwater regions (Fig. 8). This was done by visually following a drainage network that was 
calculated with the "Hydrology" toolbox in ArcGIS and Matlab from a resampled (3 m-grid) 
version of DTM-AV (hence referred to as "calculated drainage network"; provided to Nagra by 
M. Foster and R. Arrowsmith / Arizona State University). The DTM-AV hillshade was used to 
check, that the sections are not affected by major artefacts. 

Each stream (longitudinal profile) has been assigned a number (LP-1 to LP-15) according to 
Fig. 8. These numbers are used as references throughout this report. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. 8: Selected stream courses for analysis of stream longitudinal profiles (LP). 
Blue sections correspond to the dataset "drainage network TLM", red sections have been 
extended manually based on the visual inspection of the "calculated drainage network" (pro-
vided to Nagra by M. Foster and R. Arrowsmith / Arizona State University) and "DTM-AV 
hillshade". 

 

3.5.2 Extraction of elevation values and presentation of profiles 
For each stream course, points have been generated along the polyline at horizontal distances of 
10 m. Then, elevation values of the different surfaces (present topography (DTM-AV), base level 
of HDS and TDS (section 3.4), top bedrock) have been extracted at these point locations. The 
data points, representing the elevation of the different surfaces and the distance along the stream 
course, have then been used to construct the profiles. Elevation values have been scaled by factor 
10, to accentuate changes in channel gradient in the illustrations. This task of profile construction 
was executed in ArcGIS (details in Appendix 6, section C). 
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Adobe Illustrator has been used for the final editing and illustration of the profiles. In this step, 
further context has been manually added to the profiles: 

• Lithostratigraphic units of bedrock surface 

• Data basis used for stream course extraction (according to Fig. 8) 

The corresponding distances along the profiles have been determined by comparison with the 
10 m spaced points (see above) located along the stream courses. The lithostratigraphic units are 
aligned according to the intersections of stream courses and the dataset "lithostratigraphic bounda-
ries" (section 3.3.1). Since the latter dataset does not subdivide the Tertiary units, the GeoCover 
dataset (Geological Atlas of Switzerland 1:25'000) has been used as reference in case of LP-2, -3 
and -4 (Appendix 3), to indicate potential discontinuities of substrate resistance along these pro-
files. However, this was only done in the presence of reliable constraints by mapped outcrops. 
Otherwise, the bedrock surface was classified as "not differentiated". Lower sections of tributaries 
to the Rhine (LP-5 to LP-11), which mainly intersect with Triassic sediments (Keuper, Muschel-
kalk; see Appendix 1.B), have not been differentiated either. 

Finally, the presentation of stream longitudinal profiles in Adobe Illustrator also includes the 
interpretation of knickpoints / anomalies. Background is given in the subsequent section 3.5.3. 

3.5.3 Identification and interpretation of knickpoints / anomalies 
Based on the "graded river" concept, each stream longitudinal profile has been visually checked 
for anomalies. These may either be expressed as distinct knickpoints (with abruptly increasing 
stream gradient) or as less obvious "convex sections" along the profile. The visual / qualitative 
approach used here does not involve an objective / quantitative threshold for identification of 
knickpoints / anomalies. Therefore, the classification applies to features of various convexity and 
magnitude, as can be observed in the resulting profiles (Appendix 3 and Fig. 9). However, major 
transitions in the stream longitudinal profiles should be identified.  

Convex sections described above can be expressed as irregular sections (see also Fig. 9C), with a 
series of multiple, sometimes small knickpoints. Although an effort is made to differentiate such 
individual knickpoints along a convex section, they may actually correspond to one single 
(higher-order) anomaly. This will be accounted for in the interpretation of results in section 4.3. 
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Fig. 9: Concepts used for the interpretation of anomalies in stream longitudinal profiles. 
Note that the effective (present) topography in the first and third sketch is identical. 
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Based on the distance along the profile, the locations of knickpoints / anomalies have been manu-
ally projected on the map in ArcGIS (output dataset "stream profile anomalies"). The context 
displayed in the stream longitudinal profile and map view is used to interpret their potential 
signals and dynamics. While the stream longitudinal profiles already include the information of 
former base levels of erosion and bedrock depth and substrate (section 3.5.2), the map view 
extends the context by: 

• Landslide map (section 3.2) 

• DTM-AV hillshade 

• Topographic map 

• Orthophotos 

The latter three are used to identify anthropogenic effects, e.g. intersections with roads, or minor 
artefacts in the input datasets (e.g. local deviations of digitised stream courses in comparison with 
DTM-AV). Apart from such artificial causes, anomalies may be attributed to different natural 
causes. Fig. 9 is used to illustrate those that are thought to be most relevant for the study area: 

• Signals of base level drop 

• Signals of lithological control (heterogeneity of substrate resistance) 

• Signals of landslides (material input to channel by lateral landsliding) 

These will be explained in more detail in the following sections. 

A) Signals of base level drop (Fig. 9A) 
Differential rock uplift (Kirby & Whipple 2012), drainage reorganisation (Yanites et al. 2013) 
and other factors (e.g. climatic changes; Schumm 1993, Whipple & Tucker 1999, Blum & 
Törnqvist 2000) are potential causes of relative base level change in a drainage system. The ero-
sional response is expected to propagate upstream, until the stream longitudinal profile reaches a 
new equilibrium. In the transient state, the profile shows a knickpoint, where the downstream 
section has already been adjusting to the new base level and the upstream section is (possibly) 
equilibrated to a former base level (e.g. base level of TDS). Kirby & Whipple (2012) also refer to 
such an upstream section as a "perched low-relief landscape". 

Knickpoints associated with base level drop are expected to be mobile features that migrate 
upstream and may diffuse as they get to the headwater regions. 

B) Signals of lithological control (Fig. 9B) 
Given a specific drainage area, higher substrate resistance should result in a steeper channel 
gradient (e.g. Bursztyn et al. 2015). Thus, lithostratigraphic variations along the stream can pro-
duce convex anomalies and even distinct knickpoints, which usually are considered to represent 
fixed (non-migrating) features (Kirby & Whipple 2012). Nevertheless, migration might be 
possible or very slow, but is not inferable with the current analysis. 

Also, cover effects from sediments along the channel bed have been found to modify stream gra-
dients (Duvall et al. 2004), by affecting the substrate resistance. If bedload from resistant bedrock 
upstream is transported and deposited along downstream sections of weaker bedrock, this poten-
tially increases the substrate resistance and stream gradient of the latter (downstream) section. 
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However, it is assumed here, that this "steepening" of the downstream section will rather reduce 
the concavity of the stream longitudinal profile, than turn into convex sections or knickpoints. 
Nevertheless, the effect will be considered, in the discussions of section 4.3. 

C) Signals of landslides (Fig. 9C) 
Similarly, material input by lateral landslides can cause convex sections or knickpoints in stream 
longitudinal profiles (e.g. Korup et al. 2010). These may represent fixed features (Kirby & 
Whipple 2012), or rather a transient state, where the upstream propagation of incision is decelera-
ted until the additional sediment has been removed (e.g. Korup et al. 2010). In fact, landslides 
may often be the direct effect of knickpoint migration / fluvial incision in response to base level 
drop. In this case, however, the lateral material input to the channel is likely to modify the charac-
teristic shape of knickpoints purely related to base level drop. 

It is assumed here that the latter observation depends on the spatial and temporal characteristics 
of the landslide processes. One discrete event could form a distinct knickpoint, while a longer-
term process, in which lateral material input by landsliding varies both spatially and temporarily 
along a certain stream section, could produce a more complex, convex shape (e.g. gradual "rock 
slope deformation" superimposed by smaller, occasional "debris slides" (see Hungr et al. 2014 
for definitions). 

Synthesis 
In summary, it is important to note, that profile anomalies / knickpoints may be explainable by 
more than one of these signals, and in fact, they can also be the result of their interplay or super-
position. This makes it potentially more difficult to assess, whether migrating knickpoints in 
response to base level drop are involved in the system.  

As a rough guide, anomalies will be classified as (potentially) migrating knickpoints, where: 

• a signal of base level drop can be inferred, and no lithological control is indicated 

• a signal of lithological control is interpreted, however coinciding with the occurrence of late-
ral landslides 

The latter may lead to some confusion with the more common notion, that lithologically con-
trolled anomalies represent fixed features (e.g. Kirby & Whipple 2012). Nevertheless, it is 
assumed here, that lateral landslides can indicate a response to knickpoint migration, even where 
they spatially coincide with a change of substrate resistance along the stream profile. 

3.6 Extracting topographic / geological profiles 
Regional profiles across the study area were extracted in north – south and east – west direction 
as an additional way to illustrate the relation of mapped landslides (section 3.2) with the topo-
graphic and geological setting. The sampling lines of the topographic profiles have been defined 
manually, accounting for interesting locations across the study area (Appendix 1.A). The extrac-
tion of elevation values and the presentation of profiles followed the same procedure as for the 
stream longitudinal profiles (section 3.5.2). Again, sampling points have been generated along 
the profile lines at horizontal distances of 10 m. The detailed working steps in ArcGIS are 
described in Appendix 6 (section D). 
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In analogy to section 3.5, the following surfaces are displayed on the profiles in addition to the 
present topography: "base level of HDS", "base level of TDS", "top bedrock (where Quaternary 
deposits > 5 m)". Thus, the present landscape is again compared with former base levels of ero-
sion. 

Lithostratigraphic boundaries are shown on the profiles, to illustrate both their intersection with 
terrain or bedrock surface and their projection at depth. The latter also indicates the depth of the 
host rock (Opalinus Clay) within the siting region perimeter, relative to the present topography 
(and former base levels of erosion). Where defined, the lithostratigraphic boundaries at depth have 
been extracted from the input dataset "subsurface model NTB 14-02" (Nagra 2014a). This applies 
to: "Basis Tertiary", "Basis Malm (Basis Wildegg-Formation)", "Top Opalinus Clay", "Top Lias". 

Within the "subsurface model NTB 14-02", the other lithostratigraphic boundaries are not defined 
for the study area. Therefore, they were manually aligned with the defined boundaries ("Basis 
Tertiary" etc., see above) and their intersection with terrain surface according to the "lithostrati-
graphic boundaries" as derived from the GeoCover dataset (Geological Atlas of Switzerland 
1:25'000; see section 3.3.1). 

Finally, landslides have been illustrated schematically, based on the map of process domains 
(section 3.2) or visual inspection of DTM-AV hillshade and GeoCover (Geological Atlas of 
Switzerland 1:25'000) for sections outside of the map extent. 

Subsections of the regional topographic / geological profiles were also used for interpretation and 
illustration of landslide process types in the study area (see figures in section 4.2). 

3.7 Calculation of topographic parameters for map representations 
To compare the distribution of landslides with topographic parameters, additional map representa-
tions were created, where the landslide map from section 3.2 is displayed in combination with a) 
a slope gradient map (Appendix 1.E) and b) a local relief map (Appendix 1.F). Both were calcula-
ted based on the digital terrain model DHM25 (25 m grid size). The slope gradient was calculated 
with the standard algorithm implemented in ArcGIS. Local relief was calculated with the "Focal 
Statistics" toolbox (statistics type "RANGE", circular neighbourhood with radius = 500 m). 
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4 Results and Discussion 
 
The results from the previously described mapping and analyses are here discussed and inter-
preted with reference to the motivation and objectives from Chapter 1. The presentation of results 
mostly takes place in the appendices: 

• Map of process domains and landslide map, illustrated with different (additional) map content 
in Appendix 1; quantitative synthesis of the map of process domains in Appendix 2 

• Surface characteristics of individual landslides: presentation of selected variables in Appen-
dix 1, and synthesis diagrams in Appendix 2 

• Stream longitudinal profiles in Appendix 3 

• Regional topographic / geological profiles in Appendix 4 

In sections 4.1 and 4.2, the spatial distribution and characteristics of (hillslope) process domains 
and landslides are analysed, highlighting different relations to topographic and geological vari-
ables.  

In section 4.3, the present state and potential (future) dynamics of stream longitudinal profiles are 
interpreted. 

4.1 Hillslope process domains: spatial distribution, topographic and 
geological control 

The results of Appendices 1 and 2 are here used to discuss the spatial distribution of (hillslope) 
process domains and landslides as well as their topographic and geological controls. The diagrams 
of Appendix 2 contain a variety of information, with an attempt made here to extract some key 
observations. The terms "landslide" or "landslide-affected" subsequently summarise the process 
domains of both "evident landslides" and "presumed landslides". 

4.1.1 Regional spatial pattern 
Appendix 1.C shows that in general, the central part of the siting region appears rather "quiet" 
with respect to landsliding. A large proportion of this region consists of the "upland low-relief 
area" of the "Bözbergplateau" (see Appendix 1.A for location names) and "presumably unfailed 
hillslopes", associated with the lithostratigraphic domains of Tertiary sediments (Molasse), 
Villigen-Formation and Wildegg-Formation (Appendix 1.C). On the other hand, landslides within 
the mapping area appear particularly concentrated in the following regions: 

• Within Tertiary sediments (Molasse) along the Aare river, i.e. southern margin of the Böz-
bergplateau (southeastern corner of siting region) 

• Within various lithostratigraphic units along the Mandach thrust fault north of the siting 
region, from Frickberg in the west to Böttstein next to the Aare in the east 

Not very surprisingly, Appendix 1.E and F indicate the correlation of this (regional-scale) pattern 
with slope gradient and local relief. Most mapped landslides of the study area spatially coincide 
with a local relief of > 100 m (calculated for a circular window of 1 km diameter), and cor-
responding values of > ~ 200 m are observed for most of the large landslides (threshold in 
Appendix 1.F arbitrarily set to ≥ 0.2 km2). This relation is further indicated in the regional topo-
graphic / geological profiles of Appendix 4. 
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4.1.2 "Landslide susceptibility" of lithostratigraphic units 
The "landslide susceptibility" of the different lithostratigraphic units is here estimated from the 
map of process domains, as percentage of the totally mapped landslide surface in relation to the 
total hillslope area within a given lithostratigraphic unit (Tab. 4). The proportions are also indica-
ted in Appendix 2. 

Tab. 4: "Landslide susceptibility" estimated as percentage of totally mapped landslide sur-
face in relation to the total hillslope area of a given lithostratigraphic unit. 
Landslides surfaces include terrain segments of both "presumed landslides" and "evident 
landslides". 

 

Lithostratigraphic unit Total landslide 
surfaces  

[km2] 

Total hillslope  
area  
[km2] 

"Landslide 
susceptibility"  

[%] 

Tertiary sediments (Molasse) 3.6 9.9 36.5 

Villigen-Formation 0.6 5.2 12 

Wildegg-Formation 6.6 23.3 28 

Ifenthal-Formation 1.25 2.6 48 

Hauptrogenstein /  
Klingnau-Formation 1.6 4.6 34 

Passwang-Formation 2.1 3.0 70 

Opalinus Clay 3.8 4.7 81 

 
It should be noted that these results must not be considered as absolute values, given the uncer-
tainty generally involved in landslide mapping, the restriction to areal statistics (no volumes / 
rates) or the heterogeneous topographic conditions across the mapping area. Also, they are speci-
fic to the present study area and may differ in other regions. Nevertheless, the results indicate 
some trends that can partly be related to the lithologic descriptions and data on rock strength in 
Tab. 1 (Chapter 2). According to this, "landslide susceptibility" tends to increase from mostly 
calcareous (Villigen-Formation), to increasingly marly (e.g. Wildegg-Formation) and finally 
clay-rich formations (Opalinus Clay), accompanied by a decrease in rock strength. It should be 
noted again, that these observations do not include and quantify rock fall processes (see explana-
tions in section 3.2.1), which are nevertheless relevant to more brittle, calcareous lithostrati-
graphic units, particularly the Villigen-Formation and Hauptrogenstein. 

As an important observation, the pie chart presentations of landslides in Appendix 2 as well as 
the lithostratigraphic boundaries in Appendix 1.C and Appendix 4 indicate, that many of the 
larger landslides involve more than one lithostratigraphic unit. This is particularly true for the 
northern boundary of the siting region, where different lithostratigraphic units crop out at the 
surface within short distance. This implies that the "landslide susceptibility" of a lithostratigraphic 
unit (as calculated above) can be influenced by its underlying unit. For instance, most of the larger 
landslides in the Passwang-Formation also involve Opalinus Clay (forming the lower hillslope 
sections of the landslides). Although at much a lower level (12 %), the "landslide susceptibility" 
of the Villigen-Formation also seems to be significantly controlled by destabilising effects of the 
Wildegg-Formation at lower hillslope sections. 
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From the lithologic descriptions and rock strength data in Tab. 1, it can be inferred that within the 
study area, these multi-lithological landslides often correspond to a "hard-over-weak" setting, 
where the harder lithostratigraphic units at the top of hillslopes are rather "passively involved" in 
landsliding by destabilisation of their underlying (potentially weaker) lithostratigraphic units. 
This will be further discussed in the interpretation of landslide types in section 4.2. 

4.1.3 Topographic / morphometric characteristics of landslides and hillslopes 
This section particularly aims at interpreting the information on topographic / morphometric 
characteristics of landslides and hillslopes according to the diagrams of Appendix 2. Where help-
ful, again references to map representations from Appendix 1 will be made. 

As indicated by the size of the pie charts, all lithostratigraphic units intersect with landslides of 
very different size, ranging from small landslides in the order of 0.001 km2 to large and potentially 
deep-seated landslides in the order of a few 0.1 km2 or even ~ 1 km2. However, large landslides 
within the study area show some tendency of higher frequency in association with Opalinus Clay 
and within the Tertiary sediments (Molasse) towards the Aare (Appendix 1.C). This is attributed 
to: i) the spatial correlation with a higher local relief along the northern boundary of the mapping 
area and along the Aare (Appendix 1.F), combined with ii) the potential of Opalinus Clay and 
(possibly) marly layers within the Molasse sediments to facilitate deep-seated landslides. 

While local relief thus seems to be a good predictor for the spatial distribution of landslides, a 
relation with slope aspect is less obvious in the study area. This is subsequently analysed in 
more detail: 

• As pointed out in Chapter 2, bedding planes within the study area are mostly flat or gently 
dipping southward. A moderate southward directed steepening is observed near the Mandach 
thrust fault in the north and partly towards the Aare below the southern margin of the Böz-
bergplateau (Appendix 4.A). 

• Assuming a strong structural control on landslides by the orientation of bedding planes, a 
concentration of landslide surfaces on south-facing slopes would therefore be plausible. At 
least for larger (and potentially deep-seated) landslides, this is observable for the Tertiary 
sediments (Molasse), while more vaguely indicated for the Villigen-Formation, the Wildegg-
Formation and Ifenthal-Formation (Appendix 2). In case of the Passwang-Formation and 
Opalinus Clay, this dependency is not indicated at all. The comparison with the pixel-based 
distribution of hillslope orientation (summarised for both unfailed and landslide-affected) 
within each lithostratigraphic unit (Appendix 2) suggests, that the distribution of landslide 
surface orientation is strongly controlled by the general distribution of hillslope exposition. 

• These observations could indicate either that structural control (by orientation of bedding 
planes) plays a minor role for landsliding in certain lithostratigraphic units and/or that dip 
angles tend to be too flat in the study area to have a significant impact on landsliding.  

• However, potential differences with respect to shallow vs. deep-seated landslides are not 
accounted for in this observation. Therefore, with respect to depth of landslides and erosion 
rates, slope aspect in relation to dip direction may still be a relevant factor, at least for some 
lithostratigraphic units. Also, the impact of slope aspect may vary in time, as dip angles and 
directions relative to topography can locally change during landscape incision (see subsurface 
projection of lithostratigraphic boundaries in Appendix 4). 
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Finally, Appendix 2 and map representations of Appendices 1.E and 1.F show the variability of 
slope gradients of hillslopes and landslides across different lithostratigraphic units. As an addi-
tional illustration, the pixel-based slope gradients of the hillslope domain displayed in the radial 
diagrams of Appendix 2, have been rearranged as histograms in Fig. 10. From these various 
illustrations, the following observations are made: 

• Within the hillslope domain, typical hillslope angles between 5 and 25° degrees (pixel-based 
values, 2 m grid size) are observed in case of Tertiary sediments (Molasse), the Wildegg-
Formation, Ifenthal-Formation and Opalinus Clay. These lithostratigraphic units, which 
include marls or claystones (Opalinus Clay), are characterised by a unimodal histogram of 
slope gradients in Fig. 10, with modal values around 10°.  

• On the other hand, slope gradients > 30° are mostly associated with rock cliffs along plateaus 
formed by more competent calcareous rocks (Villigen-Formation, Hauptrogenstein). How-
ever, much lower values (< 15°) are observed within these lithostratigraphic units, too. This 
also reflects the fact, that the present analysis does not distinguish bedrock surfaces from 
hillslopes covered by Quaternary deposits / debris. In combination, the results are the bimodal 
histograms of the Villigen-Formation and Hauptrogenstein / Klingnau-Formation in Fig. 10.  

• Although less pronounced, the bimodal character is also indicated in case of the Passwang-
Formation. This can be explained by the fact, that this formation predominantly intersects 
with intermediate to higher hillslope sections beneath the Hauptrogenstein, where slope gra-
dients typically are still higher than in lower hillslope sections (see also Appendix 1.E for 
comparison, however, in that case displayed for DHM25, with grid size of 25 m). Also, the 
internal stratification of the Passwang-Formation (Tab. 1, Chapter 2), including more com-
petent limestone sequences aside from marls and claystones, may contribute to the distribu-
tion of slope gradients. In terms of hillslope gradients within the study area, the Passwang-
Formation can thus be considered a "hybrid" of the two other groups described above. 

• The median values of all lithostratigraphic units are higher than those calculated with a 
coarser spatial resolution of 250 m by Yanites et al. (2017), who found the following results 
for different rock types in the eastern Jura Mountains: shale = 7.4°, sandstone = 8.5°, lime-
stone = 10.8°. This shows how finer-scale hillslope features with higher slope gradients are 
smoothed on the coarse analysis scale and are therefore not adequately represented in a larger-
scale model. However, the relative increase of slope gradients from weak (shale) to more 
competent rock types (sandstones and limestone) is confirmed by both the coarse (Yanites et 
al. 2017) and the fine analysis scale (this study). 

• With respect to landslide surfaces, Appendix 2 (and Appendices 1.E and 1.F) indicates a trend 
of decreasing mean slope angles with increasing area or internal relief. This observation is 
shared for all lithostratigraphic units. However, differences are again observed with respect 
to the range of slope angles. While the mean surface orientation of large landslides inter-
secting with Tertiary sediments (Molasse) or Opalinus Clay for instance shows typical slope 
gradients in the range of 10 to 15°, a shift to higher values (> 15°) is particularly observed for 
landslides intersecting with the Villigen-Formation (although dominated by the Wildegg-
Formation). Also, some trend towards steeper landslide surfaces is observed for north-facing 
as opposed to south-facing landslides in several lithostratigraphic units. However, a differen-
tiation of shallow vs. deep-seated landsliding is again not accounted for in this observation. 
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Fig. 10: Histogram and statistical measures of slope gradients within the hillslope domain of 
the study area, separated for individual lithostratigraphic units. 
The hillslope domain summarises the classes "presumably unfailed hillslopes", "presumed 
landslides" and "evident landslides" according to the map of process domains (Appen-
dix 1.C). Slope gradients correspond to a subsample of pixel-based values from DTM-AV 
(2 m grid size), with only every tenth raster cell in both East – West and North – South direc-
tion being represented (see section 3.3.2). Number 'n' indicates the resulting number of pixels 
for each lithostratigraphic unit. The same dataset is used in the radial diagrams of Appen-
dix 2. Note that frequencies of values steeper than 45° are summarised in the histograms. 
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4.2 Landslide types 
So far, landslide-affected hillslopes have been mostly considered without differentiating landslide 
types. As pointed out in section 3.2.1, this is also difficult and not systematically applicable in 
case of the general (remote) mapping approach of this study. Still, it has important implications, 
particularly with regard to spatiotemporal characteristics of hillslope erosion: 

• Areal extent of landslide 

• Depth of movement: i.e. deep-seated vs. shallow processes (according to section 3.2.1) 

• Temporal behaviour: discrete vs. continuous / long-term processes; movement rate 

Deformation measurements, which usually are a key to process description, have not been avail-
able for this study. An attempt in the context of this study to detect recent slope movement by 
subtraction of two temporally separated DTM records (DTM Jura Ost – DTM AV), did not reveal 
any signals either. The latter may indicate, that no significant landslides occurred over the con-
sidered time interval (2001 – 2015). On the other hand, deformation rates of continuous / long-
term landslide processes in the order of mm to dm/year may also be too small to be identified by 
such change analysis (i.e. "digital elevation model of difference").  

Important landslide types of the study area are therefore identified (or interpreted) by: 

• Process description from historic records (available for few examples) 

• Interpretation based on morphological and geological characteristics, therefore, analogies 
from other landslide descriptions are used (e.g. Hungr et al. 2014) 

First, the focus is put on the kinematics of large and potentially deep-seated landslides / land-
slide complexes. "Large" means, that they typically affect an entire hillslope from a plateau / crest 
down to a valley floor or stream channel. The areal extent of such landslides in the study area 
ranges from a few 0.1 km2 to approximately 1 km2, while the internal relief ranges from ~ 100 m 
to a maximum of ~ 300 m. The term "deep-seated" is expected here to involve depths of move-
ment in the order of > 10 m up to a few tens of meters (section 3.2.1). However, the latter is only 
inferred from analogies from literature (e.g. Reichelt 1967, Hungr et al. 2014) and from the 
construction of geological cross sections, where basal rupture surfaces are (speculatively) projec-
ted from the geometry of surface features (see below). 

The second part presents earthflows, being a well-documented landslide type of the study area 
that potentially superimposes large deep-seated landslides (see below). 

Finally, other (potentially) relevant landslide types such as shallow slides or rock fall are 
addressed. 

4.2.1 Characteristics and types of large, deep-seated landsliding 
Large, deep-seated landslides (according to definition above) seem to be relatively widespread in 
the study area. They are associated with correspondingly high local relief (> 100 m, see Appen-
dix 1.F) along the northern boundary of the siting region and towards the Aare. As a result of their 
geographical distribution, they involve a variety of geological settings. This leads to different 
surface expressions and potentially different landslide kinematics. 

As a key observation it is noted, that large parts of these landslide surfaces (and likely landslide 
rupture surfaces) intersect with potentially weak rock types of marly or clayey material. In 
accordance with Hungr et al. (2014), ductile deformation is therefore expected to play an impor-
tant role for these landslides. 
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Mechanisms of brittle failure, on the other hand, are characteristic for more competent rock types. 
Within the study area, the latter are particularly represented by the calcareous rocks of the 
Villigen-Formation and Hauptrogenstein. Additionally, some competent layers can be expected 
within the Tertiary sediments (Molasse; not further differentiated here) or as more calcareous 
layers (alternating with marly layers) within the Wildegg-Formation and Passwang-Formation. 

Concerning brittle failure mechanisms, the following observations should be noted with respect 
to the study area: 

• No large landslide types12 have been observed, that would typically be associated with brittle 
failure (e.g. rapid rockslides ("Felssturz" / "Bergsturz") with long runout distance of fragmen-
ted rock material) 

• The competent lithostratigraphic units of the Villigen-Formation and Hauptrogenstein 
typically occur as cap rocks, overlying weaker lithostratigraphic units of Wildegg-Formation 
or Passwang-Formation / Opalinus Clay, respectively. In this setting, they are rather 
"passively involved" in large landslides, that have their basal rupture surface mainly located 
within the underlying (weaker) lithostratigraphic unit (see considerations in section 4.1 
"Landslide susceptibility" of lithostratigraphic units). 

The corresponding "hard-over-weak" setting is illustrated by simplified geological cross sections 
in Figs. 11 and 13 for two different geological settings of the study area. Since in these cases, the 
landslide is "favored" by the weaker lithostratigraphic unit in the lower section of the hillslope, 
large deep-seated landslides may also occur without the displayed cap rock of more competent 
material (i.e. Villigen-Formation or Hauptrogenstein). Such examples are for instance found in 
the domain of Tertiary sediments (Molasse) in the southeastern corner of the mapping area or in 
the most northern region of the study area, where the Hauptrogenstein has been completely 
eroded. 

While the large deep-seated landslides of the study area seem to involve some degree of ductile 
deformation as a common feature, the specific landslide types (kinematics) may still vary. The 
lithostratigraphic units involved and the relative orientation of discontinuities with respect to hill-
slope orientation are important factors in this process-related context. With respect to kinematics, 
a distinction is made between "slides" along a well-defined (discrete) rupture surface and the 
landslide type "rock slope deformation", where the deformation rate shows a more continuous 
transition with depth. Keeping this distinction in mind, the following landslide types (according 
to Hungr et al. 2014; Tab. 3, section 3.2.1 this study) have been attributed to different lithostrati-
graphic units of the study area and observed morphologies: 

• "Rock slope deformation": This involves potentially long-term but very slowly acting 
(~ mm to cm year13), ductile deformation, without a fully defined basal rupture surface (see 
above). This is typical for weak claystones and marls and is therefore suggested for landslides 
intersecting with Opalinus Clay (Fig. 11), but also possible for marly layers of the Tertiary 
sediments (Molasse), Wildegg-Formation, Ifenthal-Formation, Klingnau-Formation and 
Passwang-Formation. It is assumed and supported by observation (e.g. deformation of 
opposite hillslopes in Figs. 11 and 12) that "rock slope deformation" is favored by dip slopes, 
however, also commonly observed where slope aspect is opposed or oblique to the orientation 
of bedding planes / discontinuities. This is explained here by the assumption that, similar to 
soil, a deformation zone may evolve more independently from structural controls within such 
geomechanically weak material. 

                                                           
12  For smaller (rock fall) processes, see end of this section. 
13  Periodical acceleration with higher rates can occur. 
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Fig. 11: Simplified geological cross section with interpreted "rock slope deformation" on 
opposite hillslopes of Frickberg. 
Note that vertical axis is scaled by factor 2. See Appendices 1.A and 4.B for geographical 
location. For parts of the southwestern hillslope of Frickberg, an event or period of increased 
activity is documented for the year 1843, according to the Geological Atlas of Switzerland 
1:25'000. 
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Fig. 12: Surface morphology of hillslopes potentially affected by slow but continuous "rock 
slope deformation" (indicated by red arrows) on northwestern flank of Frickberg. 
This hillslope is opposed to the dip slope. For location of Frickberg, see Appendix 1.A.  

 
As mentioned above, "slides" involve movement along a fully developed basal rupture surface. 
Depending on the geometry of this rupture surface, Hungr et al. (2014) distinguish different land-
slide types, with implications for the internal and surficial deformation of the surface mass and 
landslide velocity. It is assumed that many of the slides of the study area correspond to the type 
"rock compound slide", where the rupture surface is defined by "several planes, or a surface of 
uneven curvature" (Hungr et al. 2014, p. 175). In contrast to a purely planar or cylindrical rupture 
surface, this geometry requires significant internal deformation of the landslide mass. For many 
landslides of the study area, such deformation is supported by corresponding roughness features 
at the surface, as seen for instance in the DTM derivatives of Fig. 6 (section 3.2.2).  

An interpreted example of a rock compound slide is illustrated in the cross section of Fig. 13. In 
contrast to the "rock slope deformation" of Fig. 11, this illustration should indicate a stronger 
structural control, where lithostratigraphic units are internally characterised by a sequence of less 
competent (e.g. marly) vs. more competent (e.g. calcareous) layers, with deformation favored 
along the weaker bedding planes14. While the example is shown for the Wildegg-Formation, the 
characterisation of lithostratigraphic units in Tab. 1 (Chapter 2) suggests, that such behavior may 
also apply to the Tertiary sediments (Molasse), the Ifenthal-Formation, Klingnau-Formation and 
Passwang-Formation. 

According to Hungr et al. (2014) rock compound slides may be slow or rapid. The temporal beha-
vior is certainly modified by detailed properties of the rupture surface, i.e. i) lithological proper-
ties, e.g. rather ductile / slow deformation in case of marly and clayey rupture surfaces, ii) higher 
velocities in case of steeper and more planar surfaces, iii) influence of water on rupture surfaces. 

Some of the large deep-seated landslides of the study area may also represent a transition between 
slide types and "rock slope deformation". Hungr et al. (2014, p. 189) observe, that rock slope 
deformation "may facilitate the development of compound rock slides by pre-shearing weak hori-
zons". In any case, a final classification will remain difficult in the absence of deformation mea-
surements and knowledge of the landslide structure at depth. 

                                                           
14  Although referring to a smaller landslide (< 0.1 km2), Fig. 20 suggests how sliding occurs along such well-defined 

(and at least locally planar) bedding planes within the Wildegg-Formation. 
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Fig. 13: Simplified geological cross section with interpretation of large deep-seated landslide 
on south flank of Geissberg and more shallow slope deformation on opposite hill-
slope.  
Signatures within lithostratigraphic units indicate approximate orientation of bedding planes 
(according to Geological Atlas of Switzerland 1:25'000). A photograph of the south flank of 
Geissberg is shown in Fig. 23 for comparison. For location, see Appendices 1.A and 4.A. 

 

4.2.2 Earthflows 
As a special feature of the study area, several earthflow-like landslides have been documented 
and are partly still expressed in the landscape as earthflow "tongues". Based on their number and 
depth of deformation, earthflows may be less important for the overall contribution to regional 
hillslope erosion or to an exposure of the repository than the deep-seated landsides described 
above. However, with potential velocities in the order of m/day or m/hour they represent a hazar-
dous phenomenon, which explains some of the attention they have received, and which is docu-
mented in historic records (Baltzer 1876, Hartmann 1928 and 1950, Haefeli 1940). According to 
Hungr et al. (2014, p. 187), earthflows are defined as: 

• "Rapid or slower, intermittent flow-like movement of plastic, clayey soil, facilitated by a 
combination of sliding along multiple discrete shear surfaces, and internal shear strains. Long 
periods of relative dormancy alternate with rapid 'surges' ".  

Within the study area, examples are found for the area of Schinberg (Figs. 14 to 17) and towards 
the Aare near Böttstein (Figs. 18 and 19). Except for the example in Fig. 19 (Passwang-Forma-
tion), the earthflows presented here are associated with Opalinus Clay. Earthflows can super-
impose deep-seated landslide complexes (for instance earthflow on south flank of Nassberg, 
Fig. 19). 
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Initiation or surges of earthflows may be explained by changes in pore water pressure. 
Accordingly, Hartmann (1928) and Haefeli (1940) identify springs, snowmelt and periods of 
increased rainfall as potential factors for triggering or acceleration of earthflows. In some cases, 
land-use change (e.g. forest to farming, with potential impacts on hillslope hydrology and root 
cohesion) might historically have influenced the occurrence of earthflows. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. 14: Geological cross section of Schinberg (Hartmann 1928, p. 58).  
In analogy to Fig. 11, weak lithologies are overlain by more competent Hauptrogenstein. 
Landslides (mostly interpreted as earthflow-like landslides) have been recorded in 1843, 
1882, 1926 and 1939 (Haefeli 1940). While the general dip direction points southward, these 
landslides occurred on the southwestern, western and northern slopes, which indicates that 
the occurrence of these landslides seems to be rather topographically/lithologically than 
structurally controlled. For location of Schinberg, see Appendix 1.A. 
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Fig. 15: Present-day situation at Schinberg, as seen from the west. 
Location with one of the highest (recent) landslide activity in the study area. Approximate 
locations, direction and year of recorded landslides are indicated (according to Fig. 14 and 
Geological Atlas of Switzerland 1:25'000). For location, see Appendix 1.A. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. 16: Earthflow at Schinberg from February 1924 to 1926 (Hartmann 1928, p. 61). 
See approximate location in Fig. 15. 
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Fig. 17: Earthflow at Schinberg in spring 1939 (Haefeli 1940, p. 182). 
See approximate location in Fig. 15. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. 18: Earthflow reaching the Aare near Böttstein in March 1876 (Baltzer 1876, p. 290). 
This landslide is reported to have occurred within the Opalinus Clay. Probably, this spatially 
coincides with the location of a present-day clay pit south of Böttstein; for supposed location, 
see reference to this figure in Appendix 1.A. 
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Fig. 19: Interpreted (tongue-shaped) earthflow south of Böttstein, attributed to the Passwang-
Formation according to the Geological Atlas of Switzerland 1:25'000.  
This earthflow occurred on top of a large (potentially deep-seated) landslide on the south-
flank of Nassberg. For location, see reference to this figure in Appendix 1.A. 

 

4.2.3 Additional landslide types 
While the large landslides (e.g. rock slope deformation, rock compound slide) and earthflows 
described above have already been interpreted as prominent hillslope processes of the study area, 
additional landslide types according to Tab. 3 (section 3.2.1) also contribute to total hillslope 
erosion. However, some of them may be less frequent or more difficult to detect and interpret by 
the remote mapping approach, e.g. due to i) small size of individual events, ii) weak surface 
expression of some shallow or diffuse landslide processes, iii) landslides being overprinted over 
time by other geomorphological processes or anthropogenic effects. 

As pointed out in section 3.2.1, rock fall is certainly a relevant surface process for steep cliffs of 
more competent rock (particularly Villigen-Formation and Hauptrogenstein) along the boundary 
of plateaus (e.g. Geissberg, Frickberg). 

The process type "slide" is also represented by smaller and potentially shallow landslides. This 
can for instance involve planar or rotational slides of soil or debris, triggered by heavy rainfall 
events or by fluvial erosion along channels. In some cases, near-surface bedrock may similarly 
be displaced by planar sliding along bedding planes, as interpreted from the example in Fig. 20. 

Rock fall and the smaller slides described above can superimpose large, deep-seated landslides.  

The process types "topple" and "spread" are not found to be relevant processes for landsliding in 
the study area, apart from possible small-scale toppling in rock fall source areas / cliffs. 
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Fig. 20: Head scarp of a medium-sized landslide (~ 0.07 km2) within Wildegg-Formation, 
potentially representing sliding along a (nearly) planar rupture surface corresponding 
to well-defined bedding planes.  
Red arrows indicate approximate dip direction of bedding planes and corresponding sense of 
movement of the landslide mass. The large trees within the scarp further suggest that the 
initiation of this landslide is rather old (several decades or even more). The location approxi-
mately corresponds to the coordinates 651'500 / 264'000; see also reference to this figure in 
Appendix 1.A. 

 

4.3 Stream longitudinal profiles 
The analysed stream profiles all contain anomalies, which are either expressed as distinct knick-
points or as less obvious convex sections along the profile (Appendix 3). Apart from the shape 
and magnitude (vertical offsets in the range of a few meters up to several decameters) of these 
features, differences among the individual profiles can be observed with respect to the number of 
anomalies, their relative position along the profile (distance and elevation) and lithological sub-
strate of the channel (alluvial vs. bedrock channels, lithostratigraphic units). 

Where appropriate, an attempt is made here to group profiles with similar characteristics (profile 
geometry, main direction of drainage, lithostratigraphic units). The grouping pursues the 
following purposes: 

• Identifying common signals (e.g. similar anomalies in the same lithostratigraphic units or at 
similar elevations): an interpretation can be expected to be more robust, if it is based on 
multiple observations. The latter can possibly also help "disentangle" signals of artificial vs. 
natural effects. 

• Generalisation should help to gain a "greater picture": e.g. is the potential for future fluvial 
incision homogeneous for the entire study area, or is there a regional imbalance? 

Subsequently, groups of stream profiles are described and interpreted in separate subsections. In 
the final section, the interpretation is synthesised with regard to the complete study area. 

The geographical overview of the stream courses, together with the geographical position of ano-
malies indicated in the longitudinal profiles, is to be found in Appendix 1.G. The individual 
stream longitudinal profiles from Appendix 3 are additionally grouped and presented in Fig. 21. 
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Fig. 21: Stream longitudinal profiles of the study area, grouped according to different catch-
ments. 
For detailed presentation of the individual profiles see Appendix 3. For the geographical 
location see Fig. 8 or Appendix 1.G. 
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4.3.1 "Rinikerfeld" catchment (LP-1, -12, -13, -14, -15) 
These streams, located in the northeastern part of siting region, are characterised by a common 
outlet into the Aare river near Villigen. While the headwaters of LP-1 /-14 /-15 have incised into 
the Bözbergplateau, LP-12 /-13 originate from more northern areas near Mönthal and southwest 
of Geissberg. 

In case of LP-12 /-13, the bedrock surface entirely corresponds to the Wildegg-Formation. In their 
most upper reaches (Bözbergplateau), the other profiles include shorter sections of Villigen-
Formation and "Obere Süsswassermolasse" (Tertiary sediments). Alluvial channel sections pre-
vail below an altitude of approximately 400 m a.s.l. These sections mostly correspond to the level 
of Late Pleistocene fluvial deposits (Fig. 22), which together with other Quaternary deposits fill 
the section of a former valley axis of the Aare river ("Paläo-Rinne Rinikerfeld"; see Schnellmann 
et al. 2014). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. 22: View from southeastern hillslope of Geissberg (east of Remigen) towards Riniken. 
The flat area represents the Rinikerfeld (former course of the Aare valley, filled with Quater-
nary deposits). Towards southwest, the upstream section of LP-1, which has incised into the 
inner regions of the Bözbergplateau, is indicated. For location of place names, see Appen-
dix 1.A. 

 
Between the outlet into the Aare River and the final confluence of LP-1 with the other streams, a 
steepening of the profile is observed as compared to the upstream sections. This results in a con-
vex anomaly / knickpoint at an elevation of approximately 360 m a.s.l. At this location no obvious 
signal of lithological control, anthropogenic effects / artefacts or material input by lateral land-
slides can be identified. Therefore, the anomaly is attributed to the incision of the Aare relative to 
the level of the Late Pleistocene fluvial deposits. The anomaly thus potentially represents a migra-
ting knickpoint in response to base level drop. 

Above this knickpoint, LP-13 (entirely located in the domain of Wildegg-Formation) shows a 
concave profile without distinct anomalies. This suggests that its profile section above the Rini-
kerfeld has fully adjusted to the level of Late Pleistocene fluvial deposits. 
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In analogy to the lithostratigraphic setting of LP-13, LP-12 also shows a mostly concave profile 
above the anomaly at 360 m a.s.l. However, the profile is more irregular with local anomalies 
above 400 m a.s.l. This spatially coincides with the large landslide on the south flank of Geissberg 
(Fig. 23 and Appendix 4.A), which potentially counteracts fluvial incision in this section by 
lateral material input to the channel. Therefore, the adjustment to a graded stream profile geo-
metry seems to be not fully completed yet. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. 23: Large landslide on south flank of Geissberg, potentially "counteracting" fluvial inci-
sion along stream longitudinal profile LP-12 by lateral material input. 
For location, see reference to this figure in Appendix 1.A. 

 

The remaining profiles LP-1 /-14 /-15 all show knickpoints in the headwater regions of the Böz-
bergplateau. These spatially coincide with profile sections of the Villigen-Formation, which here 
correspond to a lower altitude than in the more northerly regions of LP-12 and -13 (see also 
Appendix 4.A). The knickpoints suggest a lithological control by a higher substrate resistance in 
these calcareous rocks. Landsliding does not seem to be relevant. Following section 3.5.3, these 
knickpoints could represent fixed (or very slowly migrating) features. 

4.3.2 "Villnachern" catchment (LP-2, -3, -4) 
These streams in the southeastern part of the siting region are running from the Bözbergplateau 
near Linn towards the Aare River in the east. The bedrock mainly consists of Tertiary sediments, 
with only local outcrops of Upper Jurassic calcareous rocks (Villigen-Formation) that are mapped 
along LP-2 and possibly covered by debris in LP-3 and LP-4. All three profiles are characterised 
by a considerable elevation change (> 200 m) over relatively short distance (~ 3 km), thus 
forming the steepest streams of the study area. 

Apart from anomalies next to the Aare, which are interpreted as anthropogenic effects, the lower 
reaches (< 400 m a.s.l.) indicate regularly concave shapes. Above 400 m a.s.l., convex sections 
and knickpoints are observed in each profile. The most prominent anomalies occur in LP-2 and 
LP-3, where they spatially coincide with the transition of "Obere Süsswassermolasse" to lower 
lithostratigraphic units. In these steep transition zones, a lithological control by sections of more 
resistant substrate can be inferred (e.g. outcrop of Villigen-Formation in LP-2). Possibly, such 
more resistant sections are missing or less dominant in LP-4. This would explain the weaker 
expression of the signal in that profile. 

SW Geissberg
  

NE 
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In addition to the main knickpoints / anomalies, smaller ones can also be observed in the three 
profiles. Together, this turns the upper parts of the streams (> 400 m a.s.l.) into rather complexly 
shaped sections. According to the map of process domains (also displayed in Appendix 1.G as 
reference), this can partly be caused by material input from lateral landslides (see concepts in 
section 3.5.3). 

Although less explicit in LP-4, the consistent occurrence of knickpoints / convex sections above 
400 m a.s.l. in all three profiles could indicate knickpoint migration in response to base level drop. 
This explains the initiation of the mapped landslides, which in turn modify the shape of the stream 
profiles and decelerate (due to lateral material input to the channel) the upstream propagation of 
erosion. 

Assuming that such migrating knickpoints in response to base level drop exist, it could be argued 
that the headwater sections (> ~ 500 m a.s.l.) preserve some of the geometry of a "perched low-
relief landscape" (Fig. 9A), partly masked by landsliding. Considering its altitude, this "perched 
low-relief landscape" can potentially be related to the projected base level of TDS (see also inter-
section line with present topography in Appendix 1.D). In case of LP-4, the signal of base level 
drop has possibly been transmitted faster to the headwater region, due to the potential absence of 
more resistant sections along the channel. This gives a speculative explanation of why the 
"perched low-relief landscape" is hardly noticeable in this profile. 

In conclusion, the three profiles are considered to be subject to ongoing knickpoint migration in 
response to base level drop. This is supported by observed landslides along the channels. The 
upstream propagation of erosion is partly decelerated and modified by material input from lateral 
landslides as well as lithological control. These factors may also explain differences in the geo-
metries among the three profiles. 

4.3.3 "Sissle" catchment (LP-5, -6, -7, -8) 
These profiles belong to the "Sissle" catchment with its outlet to the Rhine River near Sisseln and 
headwater regions in the western part of the Bözbergplateau. The confluences of the different 
headwater sections are located in the region of Effingen. As a consequence, the stream profiles 
share an identical geometry over a relatively long distance. The lithostratigraphic setting of the 
upper stream sections is similar to the previously described Aare tributaries in the northeast of the 
siting region (see above). Again, the more southerly streams (LP-5, -6, -7) include short bedrock 
sections of the Villigen-Formation (calcareous rock) and "Obere Süsswassermolasse" (Tertiary 
sediments). In analogy to LP-13 and -14, the headwater section of the more northerly directed 
stream profile LP-8 has completely incised into the Wildegg-Formation. 

Below an altitude of approximately 400 m a.s.l., the bedrock surface intersects with the various 
lithostratigraphic units from the Middle Jurassic (Ifenthal-Formation) to Triassic sediments (not 
differentiated here). However, the influence of lithological heterogeneities is reduced here, as the 
stream mostly consists of alluvial rather than bedrock channel sections (as indicated by the "top 
bedrock" surface projected in Appendix 3). 

Weak convex anomalies can be interpreted at altitudes of ~ 305 and 370 m a.s.l. (identical for all 
four profiles). These could be related to incision of the Rhine relative to the level of Late Pleisto-
cene fluvial deposits. The anomaly at 370 m a.s.l. spatially coincides with landslides on the south 
flank of Frickberg. However, these profile anomalies are not accentuated, and the interpretation 
therefore remains rather speculative. 
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In analogy to the streams of the northeastern part of the siting region ("Rinikerfeld" catchment), 
the geometry of the upper stream sections appears lithologically controlled. LP-8, which has 
completely incised into the Wildegg-Formation (same as LP-13) shows a graded profile up to the 
drainage divide above 600 m a.s.l. The other profiles (LP-5, -6, -7) again show knickpoints in the 
headwater regions of the Bözbergplateau. These are attributed to lithological control by more 
resistant substrate within the Villigen-Formation (Fig. 24). Again, these knickpoints are con-
sidered fixed (or very slowly moving). The projected base levels of HDS and TDS are poorly 
constrained and therefore more hypothetical in this region. As a consequence, it is difficult to 
judge, whether the "perched low-relief landscape" above these lithologically controlled knick-
points could possibly be linked to the base level of TDS. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. 24: Knickpoint in LP-5 (northwest of Linn, 490 m a.s.l.), interpreted as lithologically 
controlled by higher substrate resistance within the Villigen-Formation (LP-5). 
For exact location, see reference to this figure in Appendix 1.A. 

 
 

4.3.4 "Ittenthal", "Sulzerbach", "Bürerbach" catchments (LP-9, -10, -11)  
The streams considered here run more or less parallel along valleys from the northern boundary 
of the siting region to the Rhine river in the north. The lithostratigraphic setting is similar for all 
three streams. The drainage divide at about 600 m a.s.l. is situated within the Wildegg-Formation. 
The steepening of (southward directed) dip angles, associated with the Mandach thrust fault (see 
Appendix 4.A), results in a closely spaced sequence of Middle to Lower Jurassic units along the 
upper reaches of the channels (> ~ 400 m a.s.l.). 

Below that altitude, the stream mostly corresponds to an alluvial channel in case of LP-9. The 
two other streams have longer bedrock channel sections. 

All three profiles indicate convex anomalies at an altitude of about 340 m a.s.l., which however 
are not expressed very distinctly. In analogy to stream profiles described above, they could be 
interpreted as the result of the incision of the Rhine with respect to the level of Late Pleistocene 
fluvial deposits. Along LP-10 and LP-11 these anomalies spatially coincide with the observation 
of lateral landslides (indicated in hillshade base map of Appendix 1.G, however located outside 
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of process domain mapping extent). These landslides could have been triggered by the above 
inferred base level drop and associated knickpoint migration. However, the landslides could also 
have occurred independently and at a different time period. 

An alternative explanation is offered in case of LP-10, where the steepening of the lowest section 
could be attributed to higher substrate resistance by Triassic sediments (Muschelkalk)15. How-
ever, this observation lacks confirmation by LP-9 and LP-11.  

Convex sections with lateral landslides are also observed at higher altitudes (> ~ 400 m a.s.l.). 
This signal is confirmed by all three profiles, although less distinct in case of LP-9. Lithologically, 
the landslide-affected sections can be attributed to the closely spaced sequence of rather weak 
Jurassic sediments described above (Opalinus Clay, Passwang-Formation, Klingnau-Formation 
(LP-11), Ifenthal-Formation). For LP-9 and LP-10, this situation with lateral landslides is indica-
ted in Appendix 4.B. Again, it is not clear, whether the landslides were initiated independently or 
as a direct result of knickpoint migration due to base level drop. At least in case of LP-10, the 
latter scenario is supported by the potential correlation of a "perched low-relief landscape" above 
approximately 450 m a.s.l. and the projected base level of TDS. However, such assumptions 
remain speculative. 

4.3.5 Synthesis 
As pointed out, the interpretation of stream longitudinal profiles is partly complicated by weakly 
expressed anomalies and the superposition of different signals (i.e. different natural and artificial / 
anthropogenic causes). However, some observations seem to be more reliable, since supported by 
a similar pattern in multiple profiles (Fig. 21): 

• Lithologically controlled knickpoints, spatially coinciding with a) outcrops of Villigen-
Formation around the Bözbergplateau and (possibly) b) the transition of "Obere Süsswasser-
molasse" to lower lithostratigraphic units in the Villnachern area 

• Convex anomalies associated with lateral landslides, particularly observed in a) stream 
profiles draining the Bözbergplateau in the Villnachern area (Molasse), and b) stream sections 
between the northern boundary of the siting region and the Mandach thrust fault (Ifenthal-
Formation to Opalinus Clay) 

• Knickpoint migration in response to the incision of the Rhine and Aare with respect to 
the level of Late Pleistocene fluvial deposits 

The latter is best expressed in LP-1, where future upstream migration of the convex anomaly at 
360 m a.s.l. should be expected. The more distinct signal in comparison to the other profiles is 
probably attributed to the unique intersection of this stream course with the "Paläo-Rinne Riniker-
feld" (former Aare valley), where the former base level seems to be preserved along a nearly flat, 
approximately 2.5 km long profile section (Fig. 22). The transition from this flat section to the 
steepened channel section downstream of 360 m a.s.l. results in the distinct signal. In the absence 
of such a flat channel section, the other profiles show less distinct (or even no obvious) anomalies 
in their lower reaches, explainable by a lower contrast of channel steepness with respect to the 
upstream section. 

  

                                                           
15  Not differentiated in the profile illustration but inferred from the Geological Atlas of Switzerland 1:25'000. 
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Differences among the profile geometries in response to the incision of the Rhine and Aare after 
Late Pleistocene can further arise from various factors: 

• Different timing / history of incision and aggradation (e.g. tributaries to the Aare experience 
later onset of incision associated with Rhine base level drop, as the signal first has to propa-
gate along the Aare) 

• Superposition of additional signals (anthropogenic, lateral landslides etc., see above 

• Variability in channel steepness of downstream sections due to cover effects from sediments 
of variable resistance along the channel bed (according to section 3.5.3 and Duvall et al. 2004) 

• Variability in channel steepness between different profiles due to different catchment size and 
(consequently) runoff regime 

Based on the signal in LP-1 (knickpoint migration of approximately 2 km horizontally and 30 m 
vertically) and less distinct signals recognisable in other profiles, it is inferred that stream profiles 
are still locally adjusting to incision of the Rhine and Aare after Late Pleistocene. 

Considering their elevation, landslide initiation due to such "recent" knickpoint migration is a 
possibility in case of LP-10 and LP-11 (~ 340 m a.s.l.). However, these landslides may be older, 
implying that they could have been reactivated but not initiated by "recent" incision. Links 
between profile anomalies and lateral landslides seem to be more typical for profile sections at 
higher altitudes (> ~ 400 m a.s.l.; LP-2, -3, -4, -9, -10, -11, -12; Fig. 23). In these cases, it can be 
speculated, that convex profile anomalies (or "masked knickpoints") are more persistent in time, 
where relatively low runoff (due to proximity to water divide) competes with material input by 
lateral landslides, typically associated with weak lithologies. This material input may either occur 
as a "landslide dam" from a rather discrete event, or by more continuous sediment supply by 
ongoing landslide activity. 

Profile anomalies within the Villigen-Formation along the Bözbergplateau can be interpreted as 
another form of temporally persistent knickpoints (lithologically controlled by higher substrate 
resistance). Considering their altitude, the "perched low-relief landscape" (e.g. Fig. 25) upstream 
of these knickpoints could nearly correspond to a steady-state situation at the time of base level 
of TDS (see Appendix 3, LP-1). In this case, the central regions of the Bözbergplateau might have 
seen only minor fluvial (and possibly glacial) incision over a relatively long time period. 
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Fig. 25: "Perched low-relief landscape" in headwater region of LP-1 (Kirchbözberg).  
For location, see reference to this figure in Appendix 1.A. The approximate location and the 
topographic context is also indicated in the regional topographic profile of Appendix 4.A. 
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5 Conclusions 
 
The analysis of hillslope / landslide processes and stream longitudinal profiles in the Jura Ost 
siting region and surrounding area indicates certain dynamics in the present (interglacial) land-
scape. It highlights that such dynamics are spatially modified by the geological and topographic 
setting in this eastern part of the Jura Mountains, dividing the study area into some rather "quiet" 
vs. "more active" areas. It is important to note, that the observed patterns and processes may be 
further modified in the future by different climatic conditions and/or by (base level) changes in 
the Aare-Rhine drainage system. 

Key observations and implications for landscape evolution and exposure scenarios 
A key indicator of recent landscape dynamics in the study area are landslides of various size and 
type. The analysis suggests, that both the "landslide susceptibility" of hillslopes and the associated 
landslide (process) types vary as a function of the geomechanical properties of the different litho-
stratigraphic units. Large (few 0.1 km2 up to 1 km2) and potentially deep-seated (> 10 m) land-
slides are widely observed, where hillslopes have reached heights of 100 m up to ~ 300 m as a 
result of the past fluvial (and partly glacial) incision. For such "high relief" areas, multi-litholo-
gical hillslopes / landslides are the more typical observation than those restricted to a single litho-
stratigraphic unit. Concerning the initial motivation of this study, the following conclusions are 
drawn for scenarios of landscape evolution and a possible landslide-related exposure of the 
repository at its late stage: 

• "Landslide susceptibility" and thus hillslope erodibility in the study area is temporally vari-
able during landscape incision, given the mostly horizontally layered sequence of geomecha-
nically heterogeneous (lithostratigraphic) units. 

• Hillslope erodibility within a lithostratigraphic unit is not only depending on its own geo-
mechanical properties, but also on those of its underlying unit(s); for instance, the Passwang-
Formation seems to be often destabilised by large landslides, that have their basal rupture 
surface mainly located within the underlying (weaker) Opalinus Clay. With respect to the 
temporal scale mentioned above, this also implies that (hillslope) erosion of a lithostrati-
graphic unit may be significantly accelerated, once fluvial incision has reached an underlying 
weaker unit (e.g. Villigen-Formation to Wildegg-Formation; Hauptrogenstein / Passwang-
Formation to Opalinus Clay). On the other hand, (hillslope) erosion may be slowed down 
again in the opposite case (e.g. Tertiary sediments (Molasse) to Villigen-Formation). 

• Different landslide types, of various spatial and temporal scale, are often superimposing 
within large landslide complexes, which potentially complicates a quantification of hillslope 
erosion rates. Many lithostratigraphic units include weak rock types (marls, claystones), 
where slow but long-term acting landslides can evolve instead of discrete and rapid hillslope 
failures. The latter, however, are also represented in the study area by earthflows, shallow 
slides or rock fall, and possibly by some large bedrock slides (however, the latter being only 
interpreted and not evidenced by historic records). 

• The positive correlation of landslide frequency and local relief confirms the basic assumption 
that future landslide activity will strongly depend on rates of fluvial (or glacial) incision. In 
this respect, the analysis of stream longitudinal profiles has revealed anomalies / knickpoints, 
which indicate upstream propagation of fluvial incision as another signal of landscape dyna-
mics in the present system. While some of them at lower altitudes (< 400 m a.s.l.) are attri-
buted to a base level drop with respect to the level of Late Pleistocene fluvial deposits (e.g. 
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Rinikerfeld), other convex anomalies are found at higher altitudes, where low runoff near the 
drainage divide seems to compete with material supply by lateral landslides within rather 
weak rock. 

• This latter observation points to the question about the rate at which the fluvial system can 
remove material coming from lateral landslides, and how this relates to the drainage area. 
This problem is relevant with respect to linking hillslope erosion and subsequent (fluvial) 
transport in numerical landscape evolution models. 

• Finally, the present study has shown, that hillslopes involving Opalinus Clay are often 
affected by large, potentially slow and deep-seated landslides. In a similar topographic and 
climatic setting, a landslide-related exposure of the repository at its late stage is therefore a 
plausible process that should be accounted for in corresponding scenario building. The latter 
effort may be supported by present-day analogies (as indicated by the reference from Appen-
dix 4.A to Fig. 11 of this report). 

Potential "hotspots" of landscape dynamics 
While the conclusions above represent rather generic observations for landscape evolution and 
exposure scenarios, the analysis does also indicate potential "hotspots" of present or future land-
scape dynamics in the study area. This includes the "high-relief" zone between the northern boun-
dary of the siting region and the Mandach thrust fault, where many (large) landslides / landslide 
complexes are observed on the hillslopes of Frickberg, Schinberg and a series of hilltops further 
towards the east. A second hotspot relates to the area west of Villnachern, where the drainage 
divide in the southern region of the Bözbergplateau might be shifted towards west, as suggested 
by comparison of stream longitudinal profiles on both sides of the plateau ("Villnachern" 
catchment vs. "Sissle" catchment; Fig. 21) and increased landslide occurrence on the eastern side. 

Morphological implications 
Apart from landscape dynamics and processes, terrain morphology, too, is spatially variable and 
modified by the different lithostratigraphic units within the study area. For instance, both slope 
gradients on hillslopes and stream gradients tend to be steeper within the more competent (cal-
careous) Villigen-Formation than within other (weaker) formations. Therefore, for a given depth 
of incision or local relief, valley width tends to increase from more competent calcareous, to marly 
and finally clay-rich formations. The same applies to stream gradients for a given drainage area, 
where steepening along channel sections of more competent lithostratigraphic units produces con-
vex sections / knickpoints in stream longitudinal profiles. These lithologically controlled anoma-
lies reduce the magnitude of fluvial incision in the upstream sections, which contributes to the 
conservation of the "upland low-relief area" of the Bözbergplateau (Fig. 25). 
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NAB 17-42

DAT.: Mar. 2018

Geological Overview (based on Nagra, 2014a)
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NAB 17-42
Map of (Hillslope) Process Domains
(+ Geological Features)
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Map of (Hillslope) Process Domains 
(+ Base Level HDS / TDS)
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Landslide Map (+ Slope Gradient Map)
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Landslide Map (+ Local Relief Map)
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Quantitative Synthesis of Hillslope Processes

DAT.: Mar. 2018

Quaternary plains and terraces

Evident landslides

Presumed landslides

Presumably unfailed hillslopes

Upland low-relief areas 46%

28%

8%

8%

10%

63.5%

19%

17.5%

10.4

6.3

1.9

1.7

2.1

Process domains [% of 
total area]

[% of 
hillslope area]

(**) box scaling proportional to
      absolute area

36.5%}

Total area [      ]km2

- slope gradient displayed
  along radial axis
- slope aspect displayed
  as azimuth direction
- frequencies of pixel-based
  values are summarized
  for slope gradients
  steeper than 30°

[      ]km2

- red arrows point at true position of pie chart centers,
where displacement was necessary to prevent overlap 

Total area = 22.4
(24.5% of total study area) 
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Surface characteristics of individual landslides intersecting with Villigen-Formation (*)
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33.2°

Areal proportion of different process domains intersecting with Villigen-Formation

(*) where areal proportion of the 
     lithostratigraphic unit is > 5% of 
     the complete landslide surface

Mean slope gradient vs. maximum elevation difference (relief) of landslide surface

Hauptrogenstein / 
Klingnau-Formation

Lias

not differentiated

Opalinus Clay

Passwang-Formation

Lithostratigraphic units

Tertiary (Molasse)

Ifenthal-Formation

Wildegg-Formation

Villigen-Formation

0.001

0.01

0.1

1.0

Quaternary plains and terraces

Evident landslides

Presumed landslides

Presumably unfailed hillslopes

Upland low-relief areas 31%

43.5%

2%

4%

19.5%

88%

4%

8%

3.3

4.6

0.2

0.4

2.1

Process domains [% of 
total area]

[% of 
hillslope area]

(**) box scaling proportional to
      absolute area

12%}

[      ]km2

Total area [      ]km2

- slope gradient displayed
  along radial axis
- slope aspect displayed
  as azimuth direction
- frequencies of pixel-based
  values are summarized
  for slope gradients
  steeper than 30°

Mean surface orientation of landslides (pie charts) and frequency of
pixel-based slope orientation within hillslope domain of the
lithostratigraphic unit (gray scaling)

> 0 - 0.25%

2.0 - 3.8%

1.0 - 2.0%

0.25 - 1.0%

red arrows point at true position of pie chart centers,
where displacement was necessary to prevent overlap 

- red arrows point at true position of pie chart centers,
where displacement was necessary to prevent overlap 

Total area = 10.6
(11.6% of total study area) 
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Surface characteristics of individual landslides intersecting with Wildegg-Formation (*)
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not differentiated
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Passwang-FormationTertiary (Molasse)

Ifenthal-Formation

Wildegg-Formation

Villigen-Formation

0.001

0.01

0.1

1.0

(*) where areal proportion of the 
     lithostratigraphic unit is > 5% of 
     the complete landslide surface

     Letter „K“ indicates predominance 
     of „Klingnau-Formation“ instead of 
     „Hauptrogenstein“ for landslides 
     east of the geographical axis 
     “Gansingen - Schinznach“

34.7°

31.7°

30.5°

33.2°

31.4°
31.1°

Total area = 33.5
(36.6% of total study area) 
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19%
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16.7

2.1
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8.2

(**) box scaling proportional to
      absolute area
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> 0 - 0.25%

2.0 - 3.4%

1.0 - 2.0%

0.25 - 1.0%

Mean slope gradient vs. maximum elevation difference (relief) of landslide surface

Lithostratigraphic units

Process domains [% of 
total area]

[% of 
hillslope area][      ]km2

Total area [      ]km2

- slope gradient displayed
  along radial axis
- slope aspect displayed
  as azimuth direction
- frequencies of pixel-based
  values are summarized
  for slope gradients
  steeper than 30°

Mean surface orientation of landslides (pie charts) and frequency of
pixel-based slope orientation within hillslope domain of the
lithostratigraphic unit (gray scaling)

red arrows point at true position of pie chart centers,
where displacement was necessary to prevent overlap 

- red arrows point at true position of pie chart centers,
where displacement was necessary to prevent overlap 
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Surface characteristics of individual landslides intersecting with Ifenthal-Formation (*)
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Ifenthal-Formation

Wildegg-Formation

Villigen-Formation
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Quantitative Synthesis of Hillslope Processes

DAT.: Mar. 2018

(*) where areal proportion of the 
     lithostratigraphic unit is > 5% of 
     the complete landslide surface

     Letter „K“ indicates predominance 
     of „Klingnau-Formation“ instead of 
     „Hauptrogenstein“ for landslides 
     east of the geographical axis 
     “Gansingen - Schinznach“

Quaternary plains and terraces

Evident landslides

Presumed landslides

Presumably unfailed hillslopes

Upland low-relief areas 13%

38.5%

18.5%

17%

13%

52%

25%

23%

0.5

1.4

0.65

0.6

0.45

(**) box scaling proportional to
      absolute area

Total area = 3.6
(3.9% of total study area) 
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48%}

> 0 - 0.25%

2.0 - 7.1%

1.0 - 2.0%

0.25 - 1.0%

Mean slope gradient vs. maximum elevation difference (relief) of landslide surface

Lithostratigraphic units

Process domains [% of 
total area]

[% of 
hillslope area][      ]km2

Total area [      ]km2

- slope gradient displayed
  along radial axis
- slope aspect displayed
  as azimuth direction
- frequencies of pixel-based
  values are summarized
  for slope gradients
  steeper than 30°

Mean surface orientation of landslides (pie charts) and frequency of
pixel-based slope orientation within hillslope domain of the
lithostratigraphic unit (gray scaling)

- red arrows point at true position of pie chart centers,
where displacement was necessary to prevent overlap 
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Surface characteristics of individual landslides intersecting with Hauptrogenstein / Klingnau-Formation (*)
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Areal proportion of different process domains intersecting with Hauptrogenstein / Klingnau-Formation

(*) where areal proportion of the 
     lithostratigraphic unit is > 5% of 
     the complete landslide surface

     Letter „K“ indicates predominance 
     of „Klingnau-Formation“ instead of 
     „Hauptrogenstein“ for landslides 
     east of the geographical axis 
     “Gansingen - Schinznach“

Hauptrogenstein / 
Klingnau-Formation

Lias

not differentiated

Opalinus Clay

Passwang-FormationTertiary (Molasse)

Ifenthal-Formation

Wildegg-Formation

Villigen-Formation
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Quaternary plains and terraces

Evident landslides

Presumed landslides

Presumably unfailed hillslopes

Upland low-relief areas 8%
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16.5%

13%
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19%
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0.4

3.0

0.9

0.7

0.2

(**) box scaling proportional to
      absolute area

34%}

Mean surface orientation of landslides (pie charts) and frequency of
pixel-based slope orientation within hillslope domain of the
lithostratigraphic unit (gray scaling)

> 0 - 0.25%

2.0 - 4.0%

1.0 - 2.0%

0.25 - 1.0%

Mean slope gradient vs. maximum elevation difference (relief) of landslide surface

Lithostratigraphic units

Process domains [% of 
total area]

[% of 
hillslope area][      ]km2

Total area [      ]km2

- slope gradient displayed
  along radial axis
- slope aspect displayed
  as azimuth direction
- frequencies of pixel-based
  values are summarized
  for slope gradients
  steeper than 30°

- red arrows point at true position of pie chart centers,
where displacement was necessary to prevent overlap 

Total area = 5.2
(5.7% of total study area) 

km   (**)2

K

K

K

K

K

K

K

K

K

K

K

K

K

K

K

K

K

K

K

K

K

K

K

K

K

K

K
K

K

K
K

K

K

K

K

K

K

K

K

K

K

K



Surface characteristics of individual landslides intersecting with Passwang-Formation (*)
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Areal proportion of different process domains intersecting with Passwang-Formation

Hauptrogenstein / 
Klingnau-Formation
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not differentiated

Opalinus Clay

Passwang-FormationTertiary (Molasse)

Ifenthal-Formation

Wildegg-Formation

Villigen-Formation
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0.1

1.0

Quantitative Synthesis of Hillslope Processes

DAT.: Mar. 2018

(*) where areal proportion of the 
     lithostratigraphic unit is > 5% of 
     the complete landslide surface

     Letter „K“ indicates predominance 
     of „Klingnau-Formation“ instead of 
     „Hauptrogenstein“ for landslides 
     east of the geographical axis 
     “Gansingen - Schinznach“

35.6°
35.1°

32.4°
31.7°

Quaternary plains and terraces

Evident landslides

Presumed landslides

Presumably unfailed hillslopes

Upland low-relief areas 0%

27%

36%

26%

11%

30%

40%

30%

0

0.9

1.2

0.9

0.4

(**) box scaling proportional to
      absolute area

70%}

> 0 - 0.25%

2.0 - 2.3%

1.0 - 2.0%

0.25 - 1.0%

Mean slope gradient vs. maximum elevation difference (relief) of landslide surface

Lithostratigraphic units

Process domains [% of 
total area]

[% of 
hillslope area][      ]km2

Total area [      ]km2

- slope gradient displayed
  along radial axis
- slope aspect displayed
  as azimuth direction
- frequencies of pixel-based
  values are summarized
  for slope gradients
  steeper than 30°

Mean surface orientation of landslides (pie charts) and frequency of
pixel-based slope orientation within hillslope domain of the
lithostratigraphic unit (gray scaling)

Total area = 3.4
(3.8% of total study area) 

km   (**)2

red arrows point at true position of pie chart centers,
where displacement was necessary to prevent overlap 

- red arrows point at true position of pie chart centers,
where displacement was necessary to prevent overlap 
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Surface characteristics of individual landslides intersecting with Opalinus Clay (*)
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Areal proportion of different process domains intersecting with Opalinus Clay

Total area 

(*) where areal proportion of the 
     lithostratigraphic unit is > 5% of 
     the complete landslide surface

     Letter „K“ indicates predominance 
     of „Klingnau-Formation“ instead of 
     „Hauptrogenstein“ for landslides 
     east of the geographical axis 
     “Gansingen - Schinznach“

Mean slope gradient vs. maximum elevation difference (relief) of landslide surface

Hauptrogenstein / 
Klingnau-Formation

Lias

not differentiated

Opalinus Clay

Passwang-Formation

Lithostratigraphic units

Tertiary (Molasse)

Ifenthal-Formation

Wildegg-Formation

Villigen-Formation

0.001

0.01

0.1

1.0

Quaternary plains and terraces

Evident landslides

Presumed landslides

Presumably unfailed hillslopes

Upland low-relief areas 1.5%

16%

34%

36.5%

12%

19%
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42%

0.1

0.9

1.8

2.0

0.7

Process domains [% of 
total area]

[% of 
hillslope area]

(**) box scaling proportional to
      absolute area

81%}

[      ]km2

[      ]km2

- slope gradient displayed
  along radial axis
- slope aspect displayed
  as azimuth direction
- frequencies of pixel-based
  values are summarized
  for slope gradients
  steeper than 30°

Mean surface orientation of landslides (pie charts) and frequency of
pixel-based slope orientation within hillslope domain of the
lithostratigraphic unit (gray scaling)

> 0 - 0.25%

2.0 - 3.3%

1.0 - 2.0%

0.25 - 1.0%

red arrows point at true position of pie chart centers,
where displacement was necessary to prevent overlap 

- red arrows point at true position of pie chart centers,
where displacement was necessary to prevent overlap 

Total area = 5.5
(6.0% of total study area) 
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This study
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List of GIS Datasets: Input Datasets

Dataset 
(as referenced in report)

Data source Type Filename(s) Supplementary information

DHM25 Swisstopo Raster dhm25_mosaic 25m grid size

DTM-AV Swisstopo Raster dtm1049; dtm1050; dtm1069; dtm1070; 2m grid size; for data processing, a "DTM-AV (Jura Ost)" is created by merging the original map tiles (dtm1049; dtm1050; dtm1069; dtm1070), see 
Appendix 5.B

DTM Jura Ost Nagra Raster dtm_jo_3dseis 0.5m grid size

DTM-AV hillshade Swisstopo (processed) Raster dtm1049_hs; dtm1050_hs; dtm1069_hs; dtm1070_hs 2m grid size; azimuth angle of the light source = 315°;  additionally, hillshades with azimuth angle of 45°, 135° and 225° have been calculated for 
"DTM-AV (Jura Ost)", see Appendix 5.B

DTM-AV slope gradient map Swisstopo (processed) Raster temporary project files; processed to "dtm_av_jo_slope",
see output dataset (Appendix 5.B) 2m grid size

DTM Jura Ost hillshade Nagra Raster hst_jo_3dseis Hillshade map calculated from "DTM Jura Ost", 0.5m grid size

GeoCover (Geological Atlas of 
Switzerland 1:25'000) Swisstopo Polygon-, Polyline-,

Point-Shapefiles FRICK_POLYGON_MAIN.shp; FRICK_LINE_AUX.shp etc. + analogous datasets for map tiles "Baden" and "Zurzach"

Quaternary map Heuberger et al. 2014 (NAB 12-20) Polygon-Shapefile quartaer_NCH100_20121110.shp

Base level of HDS Heuberger & Naef 2014 (NAB 12-35) Raster bhds_130813 25m grid size; HDS = Höhere Deckenschotter

Base level of TDS Heuberger & Naef 2014 (NAB 12-35) Raster btds_130813 25m grid size; TDS = Tiefere Deckenschotter

Top bedrock Pietsch & Jordan 2014 (NAB 14-02) Raster bqu_140612 25m grid size

Thickness of Quaternary deposits Pietsch & Jordan 2014 (NAB 14-02) Raster mqu_140612 25m grid size

Subsurface model NTB 14-02 Nagra 2014a (NTB 14-02, Dossier II) Raster BTe_union_20140930; BMa_union_20140930; 
TOp_union_20140930; TLi_union_20140930 25m grid size

Tectonic lineaments NTB 14-02 Nagra 2014a (NTB 14-02, Dossier II) Polyline-Shapefile verwerfungen.shp; Ergaenzung_Stoerungen2014.shp As published in NTB 14-02, Dossier II, Enclosure A3-1 ("Geologische Karte für das Standortgebiet Jura Ost")

Geological units NTB 14-02 Nagra 2014a (NTB 14-02, Dossier II) Polygon-Shapefile nordschweiz.shp As published in NTB 14-02, Dossier II, Enclosure A3-1 ("Geologische Karte für das Standortgebiet Jura Ost"); here only used for map representations

Drainage network TLM Swisstopo Polyline-Shapefile ExtractedData_TLM_FLIESSGEWAESSER.shp TLM = Topographic landscape model

Topographic map Swisstopo Raster PK25

Orthophotos Swisstopo Raster 645_265_r.tif etc. + adjacent map tiles of study area

Geological siting region Nagra 2008 (NTB 08-03) Polygon-Shapefile regio090129n.shp Here only used for map representations and manual intersection with topographic / geological profiles
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List of GIS Datasets: Output Datasets (1/2)

Dataset 
(as referenced in report)

Chapter
NAB 17-42

Type Filename(s) Supplementary information

Location names Point Feature Class Location_Names Manually digitized according to input dataset  "Topographic map" (PK25) and field observations

DTM-AV (Jura Ost) 3.2 Raster dtm_av_jo_clip Raster Mosaic of input dataset "DTM-AV", tiles "dtm1049"; "dtm1050"; "dtm1069"; "dtm1070"

DTM-AV slope gradient map (Jura Ost) 3.2 Raster dtm_av_jo_slope Slope gradient map calculated from "DTM-AV (Jura Ost)"

DTM-AV hillshade (lightsource azimuth 45°) 3.2 Raster dtm_av_jo_hs_045 Hillshade map calculated from "DTM-AV (Jura Ost)"

DTM-AV hillshade (lightsource azimuth 135°) 3.2 Raster dtm_av_jo_hs_135 Hillshade map calculated from "DTM-AV (Jura Ost)"

DTM-AV hillshade (lightsource azimuth 225°) 3.2 Raster dtm_av_jo_hs_225 Hillshade map calculated from "DTM-AV (Jura Ost)"

Process domains 3.2 Polygon Feature Class Process_Domains

Process domains (raster) 3.3 Raster process_domains_2m

Extent of process domain mapping 3.3 Polygon Feature Class Mapping_Extent

Lithostratigraphic boundaries (extended from
 Geological Atlas of Switzerland 1:25'000) 3.3 Polyline-Shapefile Ausstrich_Schichtgrenzen_20171016.shp Provided to Nagra by P. Jordan (16.10.2017)

Tectonic lineaments (extended from Geological 
Atlas of Switzerland 1:25'000) 3.3 Polyline-Shapefile Tekto_Linien_geol-Atlas_mod_20171016.shp Provided to Nagra by P. Jordan (16.10.2017)

Lithostratigraphic boundaries (completed) 3.3 Polyline Feature Class Litho_Boundaries Manually completed, based on datasets  "Lithostratigraphic boundaries (extended from Geological Atlas of Switzerland 1:25'000)" and "Tectonic lineaments (extended from 
Geological Atlas of Switzerland 1:25'000)"

Lithostratigraphic domains 3.3 Polygon Feature Class Litho_Domains

Lithostratigraphic domains (raster) 3.3 Raster litho_domains_2m

DTM-AV (Extent of process domain mapping) 3.3 Raster dtm_av_pd_clip "DTM-AV (Jura Ost)" clipped to "Extent of process domain mapping"

X-component of local normal vectors on
terrain surface (DTM-AV) 3.3 Raster dtm_av_pd_norm_vec_x Calculated by separate Java-Script (A. Ludwig); based on same algorithms for calculation of slope gradient and slope aspect as ArcGIS + subsequent conversion to x-/y-/z- 

coordinate system by trigonometric functions
Y-component of local normal vectors on 
terrain surface (DTM-AV) 3.3 Raster dtm_av_pd_norm_vec_y Calculated by separate Java-Script (A. Ludwig); based on same algorithms for calculation of slope gradient and slope aspect as ArcGIS + subsequent conversion to x-/y-/z- 

coordinate system by trigonometric functions
Z-component of local normal vectors on 
terrain surface (DTM-AV) 3.3 Raster dtm_av_pd_norm_vec_z Calculated by separate Java-Script (A. Ludwig); based on same algorithms for calculation of slope gradient and slope aspect as ArcGIS + subsequent conversion to x-/y-/z- 

coordinate system by trigonometric functions

Sampling points (20m grid spacing) 3.3 Point Feature Class Sampling_Points_20m Created as regular grid (20m spacing) in the area of "DTM-AV (Extent of process domain mapping)"

Hillslopes 3.3 Polygon Feature Class Hillslope_Polygons Polygons of the classes 'Presumably unfailed hillslopes'; 'Presumed landslides' and 'Evident landslides' extracted from 
"Process domains"

Hillslope sampling points (20m grid spacing) 3.3 Point Feature Class Hillslope_Sampling_Points_20m Result of intersecting "Sampling points (20m grid spacing)" with "Hillslopes"

Landslides 3.3 Polygon Feature Class Landslide_Polygons Aggregated manually from "Process domains"

Landslide centroids 3.3 Point Feature Class Landslide_Centroids Manually moved inside landslide polygons, where the centroid is located outside (in case of "irregularly" shaped landslides)

Landslides (raster) 3.3 Raster landslides_2m

Mean x-component of local normal vectors 
on landslide surfaces (DTM-AV) 3.3 Raster landslides_norm_vec_x

Mean y-component of local normal vectors 
on landslide surfaces (DTM-AV) 3.3 Raster landslides_norm_vec_y

Mean z-component of local normal vectors 
on landslide surfaces (DTM-AV) 3.3 Raster landslides_norm_vec_z

Internal relief within landslide surfaces 3.3 Raster landslides_relief Maximum elevation range within surface of individual landslides / landslide complexes

Quaternary map (TDS polygons) 3.4 Polygon Feature Class Quartaer_geologische_KarteNCH100
_TDS_20121110.shp Extract from input dataset "Quaternary map"

Quaternary map (TDS raster) 3.4 Raster nch100_tds25m

Intersection of projected base level TDS with 
present topography (raster with -9999 values) 3.4 Raster dhm25_btds_o Intersecting former base levels of erosion with present topography: resulting raster with "-9999" raster values

Intersection of projected base level TDS with 
present topography (raster with NoData values) 3.4 Raster dhm25_btds_nd Intersecting former base levels of erosion with present topography: resulting raster with "NoData" raster values

Intersection of projected base level TDS with 
present topography (bitmap) 3.4 Raster dhm25_btds_bm Bitmap representation of dhm25_btds_nd
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List of GIS Datasets: Output Datasets (2/2)

Dataset 
(as referenced in report)

Chapter
NAB 17-42

Type Filename(s) Supplementary information

Intersection of projected base level TDS with 
present topography

3.4 Polygon Feature Class Intersect_dhm25_btds dhm25_btds_bm converted to polygon feature class

Quaternary map (HDS polygons) 3.4 Polygon Feature Class Quartaer_geologische_KarteNCH100
_HDS_20121110.shp Extract from input dataset "Quaternary map"

Quaternary map (HDS raster) 3.4 Raster nch100_hds25m

Intersection of projected base level HDS with 
present topography (raster with -9999 values) 3.4 Raster dhm25_bhds_o Intersecting former base levels of erosion with present topography: resulting raster with "-9999" raster values

Intersection of projected base level HDS with
present topography (raster with NoData values) 3.4 Raster dhm25_bhds_nd Intersecting former base levels of erosion with present topography: resulting raster with "NoData" raster values

Intersection of projected base level HDS with 
present topography (bitmap) 3.4 Raster dhm25_bhds_bm Bitmap representation of dhm25_bhds_nd

Intersection of projected base level HDS with 
present topography 3.4 Polygon Feature Class Intersect_dhm25_bhds dhm25_bhds_bm converted to polygon feature class

Top bedrock (where Quaternary deposits > 5m) 3.5 Raster bqu_25m_nd5 Input dataset "Top bedrock", with "NoData" value where input dataset "Thickness of Quaternary deposits" < 5m

Stream courses 3.5 Polyline Feature Class Stream_Profile_Lines_JO Extracted and partly manually extended from input dataset "Drainage network TLM"

Stream network 3.5 Polyline Feature Class Stream_Network_JO Merged "Stream courses"

Calculated drainage network 3.5 elifepahS -enilyloP Stream_Network_JO_Calculated Provided to Nagra for this study by M. Foster and R. Arrowsmith (Arizona State University); dataset for this study was generated by merging original datasets (subbasins) 
"f39m3_ksn_1e5.shp", "f38m3_ksn_1e5.shp", "f37m3_ksn_1e5.shp" and "f36m3_ksn_1e5.shp"

Stream points (10m) 3.5 Point Feature Class Stream_Profile_Points_JO_10m Sampling points to extract elevation values along "Stream network"

Stream courses (routes) 3.5 Polyline Feature Class Stream_Profile_Routes_JO "Stream courses" converted to routes

Stream profile anomalies 3.5 Point Feature Class Stream_Profile_Anomalies_JO Location of anomalies as identified in stream longitudinal profiles and manually projected on map

Topographic profiles (sampling lines) 3.6 Polyline Feature Class Topo_Profile_Lines Manually defined sampling lines for extraction of topographic profiles

Topographic profiles (sampling points 10m) 3.6 Point Feature Class Topo_Profile_Points_10m Sampling points to extract elevation values along "Topographic profiles (sampling lines)"

Topographic profiles (routes) 3.6 Polyline Feature Class Topo_Profile_Routes "Topographic profiles (sampling lines)" converted to routes

Intersection points of topographic profiles and
lithostratigraphic boundaries at surface 3.6 Point Feature Class Topo_Profile_Points_Litho Intersection points of "Topographic profiles (sampling lines)" and "Lithostratigraphic boundaries" at surface

Basis Tertiary 3.6 Raster basis_tertiaer_ntb14_02_o Basis Tertiary according to input dataset "Subsurface model NTB 14-02", with "NoData" values replaced by "-9999"

Basis Malm (Wildegg-Formation) 3.6 Raster basis_malm_ntb14_02_o Basis Malm according to input dataset "Subsurface model NTB 14-02", with "NoData" values replaced by "-9999"

Top Opalinus Clay 3.6 Raster top_opalinus_ntb14_02_o Top Opalinus Clay according to input dataset "Subsurface model NTB 14-02", with "NoData" values replaced by "-9999"

Top Lias 3.6 Raster top_lias_ntb14_02_o Top Lias according to input dataset "Subsurface model NTB 14-02", with "NoData" values replaced by "-9999"

DHM25 (Jura Ost) 3.7 Raster dhm25_jo_clip Input dataset "DHM25" clipped to extent of "DTM-AV (Jura Ost)"

DHM25 slope gradient map (Jura Ost) 3.7 Raster dhm25_jo_slope Slope gradient map calculated from "DHM25 (Jura Ost)"

DHM25 local relief map (search radius 500m) 3.7 Raster dhm25_relief_r500m Pixel-based local relief map, based on input dataset "DHM25" and calculated within circular neighbourhood with radius 500m

Areal proportion table 3.3.1 Excel Table Areal_Proportion_Process_Domains_
Litho_Domains.xslx Output data table from Chapter 3.3.1

Hillslope orientation table 3.3.2 Excel Table Hillslope_Orientation_Pixel_based.xslx Output data table from Chapter 3.3.2

Landslide surface table 3.3.3 Excel Table Landslide_Surface_Characteristics.xlsx Output data table from Chapter 3.3.3

Stream profile table 3.5.2 Excel Table Stream_Analysis_JO_Output_Event_
Table.xlsx Output data table from Chapter 3.5.2

Topographic profile table 3.6 Excel Table Topo_Profiles_JO_Output_Event_
Table.xslx Output data table from Chapter 3.6

Topographic profile table (intersection points of 
topographic profiles and lithostratigraphic 
boundaries at surface)

3.6 Excel Table Topo_Profiles_Litho_Surface_JO_
Output_Event_Table.xslx Output data table from Chapter 3.6
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Technical documentation (NAB-17-42) 

Introduction 
This appendix is a detailed documentation of the technical processing steps in ArcGIS, related to 
the tasks outlined in sections 3.3 to 3.6 of the report. 

• Quantitative synthesis of mapping results (section 6.A) 

• Intersecting former base levels of erosion with present topography (section 6.B) 

• Extracting stream longitudinal profiles (section 6.C) 

• Extracting topographic / geological profiles (section 6.D) 

Section 3.2 "Manual mapping of landslides and (hillslope) process domains" does not involve any 
particular ArcGIS function other than the standard editing tools. Therefore, no additional 
explanations are necessary in that case. Similarly, section 3.7 "Calculation of topographic para-
meters for map representations" does not require additional explanations here. 

To provide some context, each of the sections A to D contains excerpts or summaries from the 
corresponding sections of the report. The reader is referred to the main report for further back-
ground. 

Datasets are referenced according to their reference names given in Appendix 5 and Fig. 3 of the 
main report. As to the descriptions below, it should be noted that "output datasets" of this study 
according to Appendix 5.B can also appear as "input datasets", if they are used for subsequent 
processing steps. Temporary data outputs are labelled as such. 

Filenames appearing in the screenshots can deviate from the finally assigned filenames as listed 
in Appendix 5. However, based on the descriptions of processing steps in the tables of this 
appendix, the corresponding datasets according to Appendix 5 remain traceable. 

6.A Quantitative synthesis of mapping results  

Introduction (summarised from section 3.3): 

The mapping results have been quantitatively analysed as follows: 

• Calculation of areal proportion of each process domain intersecting with a lithostratigraphic 
unit: This should indicate, whether certain lithostratigraphic units within the study area are 
rather dominated by the "hillslope" vs. "non-hillslope" domain and to what degree hillslopes 
tend to be landslide-affected (~ "landslide susceptibility" of lithostratigraphic units). 

• Distribution of pixel-based slope orientation within hillslope domain, separated for different 
lithostratigraphic units: This should indicate dependences of slope gradients on lithology and 
slope aspect. Additionally, it forms a "reference frame" for analysing slope orientations of 
landslide surfaces. 

• Calculation of surface characteristics of individual landslides / landslide complexes: This 
includes topographic characteristics (area, mean slope orientation (gradient and aspect) and 
internal relief) and the lithostratigraphic composition, which should help to identify topo-
graphic and lithological controls on landslides. 
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Data processing:  1) Areal proportion of process domains within lithostrati-
graphic units 

To calculate the areal proportion of different process domains within each lithostratigraphic unit, 
the "Zonal Histogram" tool in ArcGIS was used. As input for this, two raster datasets, representing 
both the process domains and lithostratigraphic domains, were required. The raster representing 
the "lithostratigraphic domains" is based on the dataset "lithostratigraphic boundaries", that in 
turn was manually extracted and partly interpolated based on the Geological Atlas of Switzerland 
1:25'000. The corresponding working steps in ArcGIS are listed in Tab. A6-1. 

Tab. A6-1: Calculating areal proportion of process domains within lithostratigraphic units (with 
preprocessing). 

 

Nr. Processing step Input dataset(s) ArcGIS 

1 Manual completion of litho-
stratigraphic boundaries 

Lithostratigraphic boundaries 

Tectonic lineaments 

(GeoCover) 

Editing Tool > Create Features 

Editing Tool > Merge 

2 Creating a mask (feature 
class) that represents the 
extent of process domain 
mapping  

Process domains "Select Features" tools 

Right-click on layer in TOC > 
Data > Export Data (copy of 
"process domains") 

Editing Tool > Merge 

3 Creating polygons of 
"lithostratigraphic domains" 
within mapping extent 

Lithostratigraphic boundaries 
(completed) 

Extent of process domain 
mapping 

Editing Tool > More Editing 
Tools > Advanced Editing > 
Split Polygons 

(Details in Fig. A6-1) 

4 Conversion of lithostrati-
graphic domains to raster 
(cell size = 2 m) 

Lithostratigraphic domains Conversion Tools > To Raster 
> Feature to Raster 

5 Conversion of process 
domains to raster 
(cell size = 2 m) 

Process domains Conversion Tools > To Raster 
> Feature to Raster 

6 Calculating areal 
proportions 

Lithostratigraphic domains 
(raster) 

Process domains (raster) 

Spatial Analyst Tools > Zonal 
> Zonal Histogram 

(Details in Fig. A6-2) 

 

The results of the "Zonal Histogram" tool were subsequently processed in Excel as "Areal pro-
portion table" 1 and illustrated in Adobe Illustrator. 

  

                                                           
1  Filepath within directory NAB 17-42: …/Data/Quantitative_Synthesis/Areal_Proportion_Process_Domains_ 

Litho_Domains.xlsx 
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Fig. A6-1: Creating polygons of "lithostratigraphic domains".  
First, all polylines of the dataset "lithostratigraphic boundaries (completed)" are selected 
(blue) within an editing session. By using "Split Polygons" (Advanced Editing toolbar, red 
circle), the "Extent of process domain mapping" (orange polygon) is dissected along the 
lithostratigraphic boundaries, resulting in polygons of "lithostratigraphic domains". 

 
 

 

 

 

 

 

 

Fig. A6-2: Calculating the areal proportion of different process domains within each lithostrati-
graphic domain with the "Zonal Histogram" tool. 
The result is a table, which has then been further processed in Excel as "Areal_Proportion_ 
Process_Domains_Litho_Domains.xlsx" file. 
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Data processing:  2) Distribution of pixel-based slope orientation within 
hillslope domain 

This analysis was based on derivatives of DTM-AV at a grid size of 2 m. To represent slope 
orientation, three raster datasets were calculated which store the x-, y- and z-components of local 
normal vectors on terrain surface, respectively. These were derived from pixel-wise calculations 
of slope gradient and slope aspect and transformation by trigonometric functions in a separate 
Java-Script (A. Ludwig). 

The procedure of extracting the slope orientation and the lithostratigraphic unit for a dataset of 
subsampling points is outlined in Tab. A6-2. 

Tab. A6-2: Extracting slope orientation and lithostratigraphic unit for subsampling points within 
the hillslope domain. 

 

Nr. Processing step Input dataset(s) ArcGIS 

1 Calculating x-, y- and z-
components of local 
normal vectors on terrain 
surface 

DTM-AV (Extent of process 
domain mapping) 

Separate JAVA-Script 
(A. Ludwig) 

2 Creating sampling points 
at a regular grid spacing of 
20 m 

DTM-AV (Extent of process 
domain mapping) 

Data Management Tools > 
Feature Class > Create Fishnet 

(Details in Fig. A6-3) 

3 Extracting hillslope poly-
gons from "process 
domains" 

Process domains Attribute Table > Select By 
Attributes 

Right-click on layer in TOC > 
Data > Export Data  

4 Intersecting sampling 
points with hillslope 
domain2 

Sampling points (20 m grid 
spacing) 

Hillslopes 

Analysis Tools > Overlay > 
Intersect 

(Details in Fig. A6-4) 

5 Sampling the following 
attributes for each hill-
slope sampling point: 

x- and y-component of 
local normal vectors on 
terrain surface 

lithostratigraphic unit 

Hillslope sampling points (20m 
grid spacing) 

X-component of local normal 
vectors on terrain surface 
(DTM-AV) 

Y-component of local normal 
vectors on terrain surface 
(DTM-AV) 

Lithostratigraphic domains 
(raster) 

Spatial Analyst Tools > 
Extraction > Sample 

(Details in Fig. A6-5) 
 

 

  

                                                           
2  The point features resulting from this intersection also store the information about the (hillslope) process domain 

each sampling point belongs to (i.e. "Presumably unfailed hillslopes", "Presumed landslides", "Evident landslides"). 
This is ensured by the setting "JoinAttributes (optional)" = ALL, as shown in Fig. A6-4. 
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Fig. A6.3: Using the "Create Fishnet" tool to create subsampling points at regular grid spacing 
of 20 m within "Extent of process domain mapping".  
The polygon output file "Fishnet_20m.shp" can be deleted after execution of the tool. The 
"Label points" (red circle) return the dataset, that is subsequently used as "Sampling points 
(20 m grid spacing)". 
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Fig. A6-4: Intersecting the "Sampling points (20 m grid spacing)" (here named "Fishnet_20m_ 

label") with "hillslopes" (polygons). 
The setting of "JoinAttributes (optional)" as "ALL" ensures that the resulting point features 
also store the information about the (hillslope) process domain each sampling point belongs 
to (i.e. "Presumably unfailed hillslopes", "Presumed landslides", "Evident landslides"). 

 
 
 

 

 

 

 

 

 

 

 

Fig. A6-5: Creating a table that contains the x- and y-component of local normal vectors on 
terrain surface (based on DTM-AV) as well as the lithostratigraphic unit for sub-
sampling points (20 m grid spacing) within hillslope domain. 
The resulting table has been further processed in Excel as "Hillslope_Orientation_ 
Pixel_based.xslx" file. 
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The resulting table of the sampling tool was then imported in Excel ("Hillslope orientation 
table" 3). The data were used for illustrations, that were first prepared in ArcGIS according to the 
explanations below and finally presented in Adobe Illustrator. This involved the creation of 
various shapefiles in ArcGIS that do not represent "real" geographic datasets and have therefore 
not been included in Appendix 5.B. However, the shapefiles can be found via filepath: 
…/Data/Quantitative_Synthesis/ of the NAB 17-42 directory. 

Based on the x- and y-components in the "Hillslope orientation table", data points were projected 
on a radial diagram in ArcGIS, where slope gradients are indicated along the radial axis and slope 
aspect is represented by the azimuth direction. Filtering of the data points is possible by 
lithostratigraphic units, which were previously assigned to the dataset (see Tab. A6-2). 

For the final illustration, points have been counted within subsections of the radial diagram 
(regularly divided by intervals of slope gradients (5°) and aspect (22.5°). This allowed for dis-
playing the frequencies of slope orientations for given lithostratigraphic units intersecting with 
the hillslope domain (see Appendix 2 for graphical results). 

Tab. A6-3 explains how the (empty) radial diagram has been created. Tab. A6-4 explains how the 
hillslope orientation data was subsequently illustrated in the radial diagram. 

  

                                                           
3  Filepath within directory NAB 17-42: …/Data/Quantitative_Synthesis/Hillslope_Orientation_Pixel_based.xslx 
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Tab. A6-3: Creating an (empty) radial diagram. 
 

Nr. Processing step Input dataset(s) ArcGIS 

1 Projecting radii of slope 
gradients at 5°-intervals 
("Construction_Slope_ 
Gradient_Radii.shp") 

Temporary table according 
to Fig. A6-6 

ArcCatalog > Create Feature 
Class > From XY Table… 

(analogous to Fig. A6-35 and 
Fig. A6-36) 

2 Creating circular disks 
with corresponding radii 
("Construction_Slope_ 
Gradient_Ringe.shp") 

"Construction_Slope_ 
Gradient_Radii.shp" 

(as snapping points) 

Editing Tool > Create Features 
> Construction Tools > Circles 

3 Creating "rings" of 5°-
intervals from internally 
overlapping circular disks 

"Construction_Slope_ 
Gradient_Ringe.shp" 

Editing Tool: 

Select smallest disk 

Editor > Clip 

Discard the area that intersects 

(repeat iteratively from 
smallest to largest disk) 

4 Draw lines to divide 
segments of slope aspect 
at intervals of 22.5° 

("Construction_Slope_ 
Aspect_Lines.shp") 

 Editing Tool > Create Features 

5 Intersecting circular 
intervals of slope gradients 
with segment lines of 
slope aspect to define 
"subsections" of radial 
diagram 

("Hillslope_Orientation_ 
Segments.shp") 

"Construction_Slope_ 
Gradient_Ringe.shp" 

"Construction_Slope_ 
Aspect_Lines.shp" 

Editing Tool > More Editing 
Tools > Advanced Editing > 
Split Polygons 

(analogous to Fig. A6-1) 

6 Aggregating subsections 
from 30° to 90° for 
graphic illustration in 
Appendix 2 
("Hillslope_Orientation_ 
Segments_Aggregated_ 
30deg_90deg.shp") 

"Hillslope_orientation_ 
segments.shp" 

Editing Tool > Merge 
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Tab. A6-4: Illustrating hillslope orientation in radial diagram. 
 

Nr. Processing step Input dataset(s) ArcGIS 

1 Creating data points that 
represent hillslope 
orientation by x- and  
y-components of local 
normal vectors on terrain 
surface 

"Hillslope orientation table" ArcCatalog > Create Feature 
Class > From XY Table… 

(Analogy in Fig. A6-35 and 
Fig. A6-36). 

2 Creating separate 
shapefiles for each 
lithostratigraphic unit 

"Hillslope_Orientation_ 
Points_All.shp" 

Attribute Table > Select By 
Attributes 

Right-click on layer in TOC > 
Data > Export Data 

3a 

 

 
3b 

Counting number of data 
points within each 
subsection of the radial 
diagram by a spatial join 

Storing the resulting 
"Count" column after each 
spatial join in a new 
attribute field (named 
according to the 
lithostratigraphic unit) 

"Hillslope_Orientation_ 
Segments_Aggregated_ 
30deg_90deg.shp" 

"Hillslope_Orientation_ 
Points_Opalinus.shp" etc. 

Right-click on layer in TOC > 
Joins and Relates > Joins >  

… + "spatial join" according to 
Fig. A6-7 
 
Attribute Table > Add Field 
(Long)… + Field Calculator 

… + Details Fig. A6-8 

(repeat for each 
lithostratigraphic unit) 

4 Visualising the (classified) 
percentage of data points 
within subsections of the 
radial diagram 

"Hillslope_Orientation_ 
Segments_Aggregated_ 
30deg_90deg.shp" 

Layer Symbology  
+ settings according to 
Fig. A6-9 

(repeat for each 
lithostratigraphic unit) 
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Fig. A6-6: Attribute table of shapefile "Construction_Slope_Gradient_Radii.shp". 
The column "X" stores the x-coordinate of the points that represent the radii of "slope 
gradient circles" at intervals of 5° in the radial diagram (radius = sin(slope gradient)).  
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Fig. A6-7: Spatial join to count the number of data points (hillslope orientation) within each 
subsection of the radial diagram ("Hillslope_Orientation_Segments_Aggregated 
_30deg_90deg.shp"). 
The result is saved into a new layer, whose attribute table contains an additional attribute 
field "Count" (see Fig. A6-8). The latter stores the number of data points within each sub-
section of the radial diagram. This procedure is repeated for each lithostratigraphic unit. 
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Fig. A6-8: Storing the resulting "Count" column after each spatial join in a new attribute field, 
named according to the lithostratigraphic unit (here "Opalinus").  
After running the "Field Calculator", the original field "Count" should be deleted. 

 
 

 

 

 

 

 

 

 

 

 

 

Fig. A6-9: Symbology setting of the layer "Hillslope_Orientation_Segments_Aggregated_ 
30deg_90deg.shp" to illustrate the distribution of hillslope orientation in a radial dia-
gram (filtered by lithostratigraphic unit). 
With the presented setting, the radial diagram is displayed for Opalinus Clay, by selecting 
the corresponding attribute field in the symbology setting (see red circle). By selecting 
"< Percent of Total >" the number of points within each subsection of the diagram is norma-
lised by the total number of subsampling points within the lithostratigraphic unit. 
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Data processing: "Surface characteristics of individual landslides / landslide 
complexes" 

An attempt is here made, to separate individual landslides / landslide complexes within the map 
of process domains. The basic idea is to aggregate adjacent segments of the classes "Evident 
landslides" and "Presumed landslides", if their deformation likely occurs interdependently. 

Once individual landslides have been merged and converted into a raster dataset, their topographic 
and lithostratigraphic surface characteristics are calculated from other raster datasets and dis-
played in a number of ways. This whole procedure is outlined by the subsequent series of tables 
and figures. 

Tab. A6-5: Preparing different datasets to represent individual landslides / landslide complexes. 
 

Nr. Processing step Input dataset(s) ArcGIS 

1 Manually aggregating 
segments of process 
domains into individual 
landslides / landslide 
complexes  

Process domains [copy] ArcCatalog > Copy Feature 
(Process Domains) 

Editing Tool > Merge 

2 Adding additional 
attribute "Area" to 
"Landslides" (polygons), 
to convert default attribute 
"SHAPE_Area" [m2] into 
[km2] 

Landslides Attribute Table > Add Field 
(Double)… + Field Calculator 

"Area" = "SHAPE_Area" / 
1'000'000 

3 Calculating centroid 
coordinates of each 
individual landslide / 
landslide complex 

Landslides Attribute Table > Add Field 
(Double)… + Calculate 
Geometry 

(Details in Fig. A6-10) 

4 Creating a feature class of 
"Landslide centroids" 
(points) 

Landslides a) Attribute Table > Table 
Options > Export (as Text File, 
temporary) 

b) ArcCatalog > Create Feature 
Class > From XY Table… 

(Analogy in Figs. A6-35 and 
A6-36). 

5 Manually moving 
landslide centroids into 
landslide polygons, if 
located outside (observed 
in case of "irregularly" 
shaped landslides) 

Landslide Centroids Editing Tool > Move 

6 Conversion of landslides 
(polygons) to raster  
(cell size = 2 m) 

Landslides Conversion Tools > To Raster 
> Feature to Raster 
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Fig. A6-10: Calculating the centroid coordinates of each individual landslide / landslide com-
plex.  
As a first step, empty attribute fields "Point_X" and "Point_Y" of type "Double" have to be 
added to the attribute table. The centroid coordinates are then assigned to the corresponding 
columns by the "Calculate Geometry" function. Depending on the geometry of the landslide 
polygon, the centroid coordinates may be located outside the landslide boundaries. In these 
cases, the "Landslide centroids" were later moved manually to a location inside the landslide 
boundaries. 
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Tab. A6-6: Calculating and extracting landslide surface characteristics. 
 

Nr. Processing step Input dataset(s) ArcGIS 

1 Calculating three raster 
datasets that represent the 
mean x-, y- and z-
component of local normal 
vectors on landslide 
surfaces. 

Landslides (raster) 

X-component of local normal 
vectors on terrain surface 
(DTM-AV) 

Y-component of local normal 
vectors on terrain surface 
(DTM-AV) 

Z-component of local normal 
vectors on terrain surface 
(DTM-AV) 

Spatial Analyst Tools > Zonal 
> Zonal Statistics 

(Details in Fig. A6-11) 

2 Calculating a raster dataset 
that represents the internal 
relief (maximum elevation 
range) within surface of 
each landslide.  

Landslides (raster) 

DTM-AV (Extent of process 
domain mapping) 

Spatial Analyst Tools > Zonal 
> Zonal Statistics 

(Details in Fig. A6-12) 

3 Extracting surface 
characteristics to landslide 
centroids 

(Normal vector 
representing the mean 
surface orientation of the 
landslide surface 
+ 
internal relief within 
landslide surface)  

Landslide centroids 

Mean x-component of local 
normal vectors on landslide 
surfaces (DTM-AV) 

Mean y-component of local 
normal vectors on landslide 
surfaces (DTM-AV) 

Mean z-component of local 
normal vectors on landslide 
surfaces (DTM-AV) 

Internal relief within landslide 
surfaces 

Spatial Analyst Tools > 
Extraction > Extract Multi 
Values to Points 

(Details in Fig. A6-13). 

4 Calculating mean slope 
aspect of landslide surface 

Landslide centroids Attribute Table > Add Field 
("mean_aspect", type Double) 
+ Field Calculator 

(Details in Fig. A6-14) 

5 Calculating mean slope 
gradient of landslide 
surface 

Landslide centroids Attribute Table > Add Field 
("mean_slope", type Double) + 
Field Calculator 

(Details in Fig. A6-15) 

6 Displaying mean slope 
orientation of landslide 
surfaces on a map 

Landslide centroids Layer Symbology 
+ setting according to  
Fig. A6-16 
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Fig. A6-11: Calculating a raster dataset that shows the mean x-component of local normal vectors 
on individual landslide surfaces. 
This procedure is repeated analogously for the y- and z-component. Together, the three 
resulting datasets indicate the mean surface orientation of each landslide. 

 
 
 

 

 

 

 

 
 
 
 

Fig. A6-12: Calculating a raster dataset that shows the internal relief (maximum elevation dif-
ference) within individual landslide surfaces. 
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Fig. A6-13: Extracting landslide surface characteristics to landslide centroids. 
The selected input rasters correspond to temporary file versions of: 1) – 3) Mean x/-y-/z-
component of local normal vectors on landslide surfaces (DTM-AV); this describes the mean 
surface orientation of each individual landslide / landslide complex 4) Internal relief within 
landslide surfaces. 

 
 

 

 

 

 

 

 

 

 

 

 

 

 
 
 
Fig. A6-14: Calculating mean slope aspect of landslide surfaces in attribute table of "Landslide 

centroids". 
Mean slope aspect is calculated by trigonometric functions from the mean x- and y-compo-
nents of local normal vectors on landslide surfaces (as derived according to Tab. A6-6 and 
Fig. A6-11). 
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Fig. A6-15: Calculating mean slope gradient of landslide surfaces in the attribute table of "Land-

slide centroids". 
Mean slope gradient is calculated by trigonometric functions from the mean x-, y- and z-
components of local normal vectors on landslide surfaces (as derived according to Tab. A6-6 
and Fig. A6-11). 
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Fig. A6-16: Symbology setting to display the mean slope orientation of landslide surfaces on a 

map. 
The mean slope aspect of the landslide surface is thus displayed by a rotated arrow (the mean 
slope gradient can be displayed by a label). 

 
While the mean x-, y- and z-components of local normal vectors on the individual landslide 
surfaces are valid parameters to calculate the mean slope aspect and slope gradient (Figs. A6-14 
and A6-15), they can not immediately be used to be plotted on a radial diagram as introduced in 
Tabs. A6-3 and A6-4 (and illustrated in Appendix 2). 

This arises from the following fact: 

• Each local normal vector on the surface is defined by unit length = 1. If all local normal 
vectors within a (landslide) surface were directed exactly in the same direction (i.e. repre-
senting a planar surface), the mean normal vector (vector sum rescaled by number n vectors) 
would also have a length = 1. 

• However, since the landslide surfaces are not planar, the resulting mean normal vector has a 
length < 1. Proportionally to this length, the x-, y- and z- components are also shorter, than 
would be the case if vector length = 1. 

Therefore, the x- and y- components need to be rescaled according to the length of the mean 
normal vector, in order that they can be correctly plotted in the radial diagram. This step is 
described in Tab. A6-7. 
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Tab. A6-7: Rescaling the mean x- and y- components of local normal vectors on the individual 
landslide surfaces, to be plotted correctly in the radial diagram. 

 

Nr. Processing step Input dataset(s) ArcGIS 

1 Calculating the length of 
the mean vector of local 
normal vectors on 
landslide surface 

Landslide centroids Attribute Table > Add Field 
("mean_vecl", type Double) + 
Field Calculator 

(Details in Fig. A6-17) 

2 Rescaling the x- and y-
components in new 
attribute fields (dividing 
by vector length) 

Landslide centroids Attribute Table > Add Field 
("mean_x_cor" and 
"mean_y_cor", type Double) 

+ Field Calculator 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
Fig. A6-17: Calculating the length of the mean vector of local normal vectors on landslide sur-

faces. 
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Tab. A6-8: Extending the list of landslide surface characteristics by the lithostratigraphic com-
position. 

 

Nr. Processing step Input dataset(s) ArcGIS 

1 Calculating the areal 
proportion of different 
lithostratigraphic units 
intersecting with the 
landslide surface 

Landslides (raster) 

Lithostratigraphic domains 
(raster) 

Spatial Analyst Tools > Zonal 
> Zonal Histogram 

(Details in Fig. A6-18) 

2 Extending the resulting 
table with a numeric 
attribute field to store the 
"landslide ID" 

Temporary table Attribute Table > Add Field 
("Nr", type Short Integer) + 
Field Calculator 

(Details in Fig. A6-19) 

3 Joining the 
lithostratigraphic surface 
characteristics with the 
topographic ones (as 
derived in Tabs. A6-6 and 
A6-7) 

Temporary table 

Landslide centroids 

Right-click on layer in TOC > 
Joins and Relates > Joins >  

… + "relational join" according 
to Fig. A6-7 

4 Export the joint attribute 
table with all landslide 
surface characteristics  

Landslide centroids Attribute Table > Table 
Options > Export (as Text File) 

 
The exported table is subsequently processed in Excel as "Landslide surface table" 4 and used for 
further illustrations (Tab. A6-9). 

 
 

 

 

 

 

 

 

Fig. A6-18: Calculating the areal proportion of different lithostratigraphic units intersecting with 
the landslide surface, by "Zonal histogram". 

 
  

                                                           
4  Filepath within directory NAB 17-42: …/Data/Quantitative_Synthesis/Landslide_Surface_Characteristics.xlsx 
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Fig. A6-19: The resulting (temporary) table stores the "landslide ID" in a text field ("LABEL").  
A numeric field ("NR") is therefore added to the table and the IDs are assigned to this new 
field via Field Calculator (= "LABEL"). 

This step allows for the table to be used in a subsequent relational join (Fig. A6-20). 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
Fig. A6-20: Joining the lithostratigraphic characteristics of the landslide surfaces with the topo-

graphic ones (as derived in Tabs. A6-6 and A6-7). 
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Tab. A6-9: Illustrating landslide surface characteristics in diagrams. 
 

Nr. Processing step Input dataset(s) (Excel) / ArcGIS 

1 Rescaling "mean_slope" 
by factor 10 for later 
illustration 

Landslide surface table Excel formula in a separately 
added column 
"mean_slope_10x" 

2 Creating data points that 
represent mean slope 
gradient (scaled by factor 
10, y-axis) vs. internal 
relief (x-axis) of landslide 
surfaces 

Landslide surface table 

(coordinates defined by 
attribute fields "mean_slope_ 
10x" and "relief") 

ArcCatalog > Create Feature 
Class > From XY Table… 

(Analogy in Figs. A6-35 and 
A6-36). 

3 Creating data points that 
represent mean orientation 
of landslide surfaces by 
mean x- and y-compo-
nents of local normal 
vectors on terrain surface 
(to be displayed in radial 
diagram) 

Landslide surface table 
 
(coordinates defined by 
attribute fields "mean_x_ cor" 
and "mean_y_cor" according to 
Tab. A6-7) 

ArcCatalog > Create Feature 
Class > From XY Table… 

(Analogy in Figs. A6-35 and 
A6-36) 

4 Adding artificial data 
points to manipulate the 
dataset in a way, that the 
symbol scaling (as a 
function of landslide area, 
step 5) is identical for all 
lithostratigraphic units 

"Landslides_Slope_Relief_ 
Data_Points.shp" 

"Landslides_Litho_Morpho_Da
ta_Points.shp" 

Editing Tool > Create Features 

(Details in Fig. A6-22) 

5 Plotting the data points 
from steps 2 and 3 in 
separate diagrams. 

Each data point (landslide) 
represented by a pie chart, 
to show the lithostrati-
graphic composition of its 
surface. Size of the pie 
chart is scaled as a func-
tion of the landslide area.  

"Landslides_Slope_Relief_ 
Data_Points.shp" 

"Landslides_Litho_Morpho_ 
Data_Points.shp" 

Attribute Table > Add Field 
("Pie_Size", type Double) + 
Field Calculator 

(Details in Fig. A6-21) 

 

Layer Symbology 
+ setting according to  
Fig. A6-23. 
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Fig. A6-21: Calculating a field to be used for size scaling of pie chart representations of indivi-
dual landslides (function of the landslide surface area and layout scale, arbitrary). 

 
 

 

 

 

 

 

 
 

Fig. A6-22: Adding one artificial data point per lithostratigraphic unit to the datasets 
"Landslides_Slope_Relief_Data_Points.shp" and "Landslides_Litho_Morpho_ 
Data_Points.shp".  
The identical area of 0.001 km2, which is slightly smaller than the smallest mapped landslide, 
defines an equal minimum of symbol size for all lithostratigraphic units and thus ensures a 
consistent size scaling in Appendix 2.  

These data points are created at artificial locations / coordinates outside the scope of the 
actual data points. A more sophisticated method for this workaround may be implemented in 
future applications. 
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Fig. A6-23: Symbology setting of the layer "Landslides_Litho_Morpho_Data_Points.shp" to 
show individual landslides as pie charts with the following properties: i) size of pie 
chart indicates landslide area; ii) segments of pie charts indicate areal proportion of 
the different lithostratigraphic units intersecting with the landslide surface. 
The attribute fields (red box) defining the pie chart segments have to be selected from the 
left-hand side "Field Selection" list. The definition query can be used to apply a "lithostrati-
graphic" filter, e.g. displaying only landslides where areal proportion of a lithostratigraphic 
unit is > 5 % of the complete landslide surface (("PASSWANG_F" *4/ ("Area" *1000000)) 
> 0.05; factor 4 is used to multiply the number of raster cells by the cell size of 2 m × 2 m). 
The dataset "Landslides_Slope_Relief_Data_ Points.shp" is displayed in the same way. 
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6.B Intersecting former base levels of erosion with present topography 

Introduction (summarised from section 3.4): 

The aim of this processing step is to indicate a simplified minimum terrain elevation at the time 
of the former base levels "Höhere Deckenschotter" (HDS) and "Tiefere Deckenschotter" (TDS). 

The two input datasets "Base level of HDS" and "Base level of TDS" represent regionally inter-
polated (nearly planar) surfaces. These interpolated surfaces technically "undercut" the present 
topography, if the latter is higher. While this represents a real situation in regions presently 
covered by the corresponding Quaternary deposit (e.g. HDS), such "undercutting surfaces" are of 
course only theoretical in the absence of these deposits.  

Therefore, new raster datasets have been created, where these "undercutting" surfaces are exclu-
ded in the absence of HDS or TDS deposits, respectively. For illustration purposes, the resulting 
raster datasets are finally converted into polygon feature classes. On the map, these polygon 
feature classes display the intersection of the projected base levels of HDS and TDS with present 
topography (DHM25). 
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Data processing:  "Intersecting former base levels of erosion with present 
topography" 

The detailed working steps of intersecting former base levels of erosion with the present topo-
graphy in ArcGIS are listed in Tab. A6-10 (example HDS; analogously for TDS). Additional 
explanations are given below. 

Tab. A6-10: Intersecting former base levels of erosion (example "Höhere Deckenschotter" = 
HDS) with present topography. 

 

Nr. Processing step Input dataset(s) ArcGIS 

1. Extracting HDS-
polygons from shapefile 

Quaternary map Attribute Table > Select By 
Attributes 

Right-click on layer in TOC > 
Data > Export Data 

2. Conversion of HDS-
shapefile to raster 
(cell size = 25 m) 

Quaternary map (HDS polygons) Conversion Tools > To Raster 
> Feature to Raster 

3. Intersecting base level of 
HDS with present 
topography 

DHM25 

Base level of HDS 

Quaternary map (HDS raster) 

Spatial Analyst Tools > Map 
Algebra > Raster Calculator 

(Details in Fig. A6-24 and 
explanations in text) 

4. Replacing "-9999" values 
by "NoData" in the 
resulting raster 

Intersection of projected base 
level HDS with present 
topography (raster with -9999 
values) 

(dhm25_bhds_o) 

Spatial Analyst Tools > 
Conditional > Set Null 

(Details in Fig. A6-25) 

5. Converting raster to 
bitmap 

Intersection of projected base 
level HDS with present 
topography (raster with NoData 
values) 

(dhm25_bhds_nd) 

Spatial Analyst Tools > 
Conditional > Con 

(Details in Fig. A6-26) 

6. Converting bitmap to 
polygon feature 

Intersection of projected base 
level HDS with present 
topography (bitmap) 

(dhm25_bhds_bm) 

Conversion Tools > From 
Raster > Raster to Polygon 

(Details in Fig. A6-27) 
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Step 3 of Tab. A6-10 uses the following criteria, to create a raster dataset without "undercutting" 
surfaces: 

• Elevation value of "base level of HDS", where deposits of HDS are indicated in "Quaternary 
map" 

• Else: Elevation value of "base level of HDS", where higher than present topography 
("DHM25") 

• Else: -9999 (no HDS deposits and DHM25 > "base level of HDS") 

These conditions are summarised in the ArcGIS Raster Calculator expression of Fig. A6-24. 

 
 

 

 

 

 

 

 

 

 

 

 

 

Con(IsNull("AUSZÜGE_TEMPORÄR\Quartaer_geologische_KarteNCH100_20121110\NC
H100_HDS25m"),Con("GRUNDLAGEN\DHM\dhm25_mosaic" > 
"DECKENSCHOTTER\NAB-12-35\Deckenschotter_20141211\HDS\bhds_130813", -9999, 
"DECKENSCHOTTER\NAB-12-
35\Deckenschotter_20141211\HDS\bhds_130813"),"DECKENSCHOTTER\NAB-12-
35\Deckenschotter_20141211\HDS\bhds_130813") 

Fig. A6-24: Using Raster Calculator to intersect base level of HDS with present topography. 
The complete expression used in the Raster Calculator is inserted as text at the bottom. See 
text of this section for explanations. Bold elements indicate filenames according to Appen-
dix 5. For base level of TDS, the procedure is analogous. 

 
For further processing, an additional raster has been created (Tab. A6-10, step 4) where the 
"-9999" values in the output dataset of step 3 are replaced by "NoData" values (Fig. A6-25). 
"NoData" raster values are displayed transparently in ArcGIS. The resulting raster datasets can 
be displayed in combination with the DTM hillshade of the present topography. This allows for 
visualisation of how a simplified minimum terrain surface at the time of the former base level 
could have looked like. 

Similarly, steps 5 and 6 are used to create a polygon feature class that spatially displays the inter-
section of the projected base level of HDS with present topography (DHM25).   



 A6-29 NAGRA NAB 17-42 
Appendix 6 

 

 

 

 

 

 

 

 

Fig. A6-25: Replacing "-9999" raster values by "NoData". 
 
 
 

 

 

 

 

 

 

 

Fig. A6-26: Converting raster to "bitmap". 
 
 
 

 

 

 

 

 
 

Fig. A6-27: Converting "bitmap" into polygon feature class for final illustration. 
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6.C Extracting stream longitudinal profiles 

Introduction (summarised from section 3.5): 
Stream longitudinal profiles are extracted here for 15 tributaries to the Aare and Rhine with head-
waters in the central Jura Ost siting region (Fig. A6-28). Apart from the present topography, the 
resulting profiles display the following information: 

• Base level of HDS 

• Base level of TDS 

• Top bedrock (where Quaternary deposits > 5 m) 

• Lithostratigraphic units of bedrock surface 

The following sections outline the technical procedure of their extraction. 

Data processing:  "Selection of stream courses" 
For extraction of stream longitudinal profiles, stream courses have been selected from the input 
dataset "drainage network TLM" (Fig. A6-28). These data are part of the Topographic Landscape 
Model 'TLM' by swisstopo. 

In some cases, the polylines of the "drainage network TLM" had to be extended manually for the 
headwater regions (Fig. A6-28). This was done by visually following a drainage network that was 
calculated with the "Hydrology" toolbox in ArcGIS and Matlab from a resampled (3 m-grid) 
version of DTM-AV (hence referred to as "calculated drainage network"; provided to Nagra by 
M. Foster and R. Arrowsmith / Arizona State University). The DTM-AV hillshade was used to 
check, that these sections are not affected by major artefacts. 

Each stream (longitudinal profile) has been assigned a number (LP-1 to LP-15) according to 
Fig. A6-28. 
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Fig. A6-28: Selected stream courses for stream longitudinal profiles (LP). 
Blue sections correspond to the dataset "drainage network TLM", red sections have been 
extended manually based on the visual inspection of the "calculated drainage network" 
(provided to Nagra by M. Foster and R. Arrowsmith / Arizona State University) and "DTM-
AV hillshade". 
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Tab. 11: Selection of stream courses. 
 

Nr. Processing step Input dataset(s) ArcGIS 

1. Extraction of stream 
sections (polylines) 
belonging to an individual 
stream and export as a 
separate (temporary) 
shapefile 

Drainage network TLM "Select Features" tools 

Right-click on layer in TOC > 
Data > Export Data 

2. If necessary: manually 
extending the stream 
course by additional 
section towards headwater 
region 

Temporary shapefile (step 1) 

"Base map":  
Calculated drainage network 
DTM-AV hillshade 

Editing Tool > Create Features 
 
 

3. Merge all sections Temporary shapefile  
(step 1/2) 

Editing Tool > Merge 

4. Creating one permanent 
feature class, that contains 
all individual stream 
courses as single features 

Temporary shapefiles (one for 
each individual stream course) 
from step 3 

Data Management Tools > 
General > Merge 

5. Manually assigning 
reference numbers (1 to 
15) to stream courses  

Stream courses Attribute Table > Add Field 
("StreamA_Nr") 

(see Fig. A6-28) 
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Data processing:  "Extraction of elevation values" 
For each stream course, points have been generated along the polyline at horizontal distances of 
10 m. Then, elevation values of different surfaces (present topography, base level of HDS, base 
level of TDS, top bedrock) have been extracted at these point locations, to be projected on the 
stream longitudinal profiles. Tab. A6-12 and corresponding figures summarise the processing 
steps in detail. 

Tab. A6-12: Projection of sampling points (Stream points (10 m)) on profile lines (Stream courses 
(routes)). 

 

Nr. Processing step Input dataset(s) ArcGIS 

1. Preprocessing input raster 
Top bedrock  

Top bedrock 

Thickness of Quaternary 
deposits 

Spatial Analyst Tools > 
Conditional > Set Null 

(Details in Fig. A6-29) 

2. Creating stream network 
(without overlapping 
polyline sections) 

Stream courses Data Management Tools > 
Generalisation > Dissolve 

3. Creating sampling points 
along stream network (at 
regular distances of 10m) 

Stream network Data Management Tools > 
Sampling > Generate Points 
Along Lines 

(Details in Fig. A6-30) 

4. Extracting elevation 
values at sampling point 
locations 

Stream points (10 m) 

DTM-AV 

Base level of HDS 

Base level of TDS          (*) 

Top bedrock 

Spatial Analyst Tools > 
Extraction > Extract Multi 
Values to Points 

(Details in Fig. A6-31) 

5. Convert stream courses to 
route elements (for linear 
referencing) 

Stream courses Linear Referencing Tools > 
Create Routes 

(Details in Fig. A6-32) 

6. Locating points along 
routes (measures distance 
of sampling points along 
stream courses) 

Stream points (10 m) 
Stream courses (routes) 

Linear Referencing Tools > 
Locate Features Along Routes 

(Details in Fig. A6-33) 

(*) preprocessed according to Tab. A6-10 (HDS, TDS) and step 1 of this table (Top bedrock) resp. 

 
As shown in Fig. A6-34, elevation values are finally scaled by factor 10, to accentuate changes 
in channel gradient in the resulting illustrations. 
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Fig. A6-29: Preprocessing input raster "Top bedrock" with Raster Calculator. 
A copy of the input dataset "Top bedrock" (bqu_140612) is created here. However, cell 
values are set to "NoData", where Quaternary deposits have a thickness of less than 5 m. 
With this condition, the stream longitudinal profiles will only display "Top bedrock" in 
sections of thicker Quaternary deposits. 

 

 

 

 

 

 

 

Fig. A6-30: Creating sampling points for profile extraction along the stream network. 

 

 

 

 

 

 

 

 

Fig. A6-31: Extracting elevation values at sampling point locations. 
The selected input rasters correspond to: 1) DTM-AV (here named "dtmnch_2m"); 2) Base 
level of HDS; 3) Base level of TDS; 4) Top bedrock (with 2, 3 and 4 modified according to 
Tabs. A6-10 and A6-12). 
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Fig. A6-32: Convert stream courses to route elements (for linear referencing). 
 
 

 
 

Fig. A6-33: Locating points along routes (measures distance of sampling points along stream 
courses). 
The output is a txt-file containing elevation values and distance of sampling points along 
stream courses. The table has been exported and processed in Excel as "Stream profile table"5 
(see Fig. A6-34). 

  

                                                           
5  Filepath within directory NAB 17-42: …/Data/Profile_Construction_Stream_Profiles/Stream_Analysis_JO_ 

Output_Event_Table.xlsx 
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Fig. A6-34: "Stream profile table": Editing the resulting txt-file from point projections 

(Tab. A6-12 and Fig. A6-33) in MS Excel, as input for subsequent plotting of stream 
longitudinal profiles. 
For subsequent illustration purposes, additional columns are added on the right (red box) to 
rescale elevation values of input rasters by factor 10 (DTM-AV = column 'G'; Base level of 
HDS = column 'H'; Base level of TDS = column 'I'; Top Bedrock = column 'J'). The cor-
responding Excel formula (red circle) also sets "NoData" values (empty cells) to -9999. The 
metric distance along the stream course is given by column 'B' (MEAS). Column 'C' 
(distance) instead contains the shortest distance of the sampling point to the stream course 
(~ zero). 
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Data processing:  "Profile construction" 
Based on the "Stream profile table" in Fig. A6-34, the stream longitudinal profiles can be dis-
played with a few more processing steps. This is also done in ArcGIS, in order to benefit from 
useful axis scaling and symbology features. Tab. A6-13 lists the detailed processing steps, with 
subsequent figures containing corresponding illustrations. 

This involved the creation of various shapefiles in ArcGIS that do not represent "real" geographic 
datasets and have therefore not been included in Appendix 5.B. However, the shapefiles can be 
found via filepath: …/Data/Profile_Construction_Stream_Profiles/ of the NAB 17-42 directory. 

Tab. A6-13: Construction of stream longitudinal profiles. 
 

Nr. Processing step Input dataset(s) ArcGIS 

1. Creating point shapefiles, 
representing elevation 
values of extracted 
surfaces along stream 
long. profiles 

Stream profile table ArcCatalog > Create Feature 
Class > From XY Table… 

(Details in Figs. A6-35 and 
A6-36). 

2. Assigning label of the 
represented surface in the 
attribute table  

Temporary shapefiles  
(step 1) 

Attribute Table > Add Field… 
+ Field Calculator 
 
(Details in Fig. A6-37) 

3. Creating one permanent 
shapefile, that contains the 
data points of all surfaces 
and streams 

Temporary shapefiles  
(step 2) 

Data Management Tools > 
General > Merge 

4. Clearing up the final point 
shapefile by deleting 
points plotted at elevation 
level of -9999 
(~ "NoData") 

"Stream_LP_JO_10x_All_ 
Surfaces_Data_Points.shp" 

Editor > Start Editing  

"Select Features" tools  

Attribute Table > "Delete 
selected" 

(Details in Fig. A6-38) 

5. Grouping the points 
according to the stream 
longitudinal profile and 
surface they belong to 

"Stream_LP_JO_10x_All_ 
Surfaces_Data_Points.shp" 

Attribute Table > Add Field… 
+ Field Calculator 
 
(Details in Fig. A6-39) 

6. Converting (grouped) 
profile points to profile 
lines 

"Stream_LP_JO_10x_All_ 
Surfaces_Lines.shp" 

"Stream_LP_JO_10x_All_ 
Surfaces_Data_Points.shp" 

Data Management Tools > 
Features > Point to Line 

(Details in Figs. A6-40 to 
A6-42) 

 
The final editing of the resulting profiles is done in Adobe Illustrator (results in Appendix 3)6. 

                                                           
6  Unfortunately, converting points to lines according to Fig. A6-40 can result in linearly interpolated segments in the 

absence of data points (surface "Top bedrock", where Quaternary deposits < 5 m). These artificial connections have 
been removed manually in Adobe Illustrator.  



NAGRA NAB 17-42 A6-38 
Appendix 6  
  

 

 

 

 

 

 

 

 

 

 

 
 
 
 
 

Fig. A6-35: Creating point shapefiles from the "Stream profile table" (Fig. A6-34), for repre-
sentation of data points in (two-dimensional) stream longitudinal profiles. 
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Fig. A6-36: Creating a shapefile of data points, representing elevation values of present topo-
graphy along stream longitudinal profiles (continued from Fig. A6-35). 
The input field 'MEAS' contains the distance of the sampling point along a stream longi-
tudinal profile (see Fig. A6-33). The field dtmnch_2m_10x contains the elevation of present 
topography (DTM-AV) at the corresponding location, scaled by factor 10. The definition of 
the spatial reference system (Coordinate System of Input Coordinates) is required to ensure 
correct axis scaling. The procedure is repeated analogously for the data point representation 
of base level HDS, base level TDS and top bedrock. 
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Fig. A6-37: Attribute table of the temporary point shapefile created in Fig. A6-36 (representing 
elevation values of present topography along stream longitudinal profiles). 
An additional field (type text) called "Surface" must be added to the attribute table. The label 
of the surface represented by the shapefile (here DTM-AV) is assigned with the 'Field calcu-
lator'. The procedure is repeated analogously for the shapefiles representing base level HDS, 
base level TDS and top bedrock. 
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Fig. A6-38: Clearing up the final point shapefile by deleting data points plotting at elevation level 
-9999 ("NoData"). 
This is done by standard ArcGIS editing: "Select Features" tools + "Delete selected" (red 
circle) in attribute table.  
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Fig. A6-39: Attribute table of the final point shapefile, representing elevation values of all sur-
faces along stream longitudinal profiles. 
An additional field (type text) called "Line_ID" must be added to the attribute table. With the 
expression in the 'Field Calculator' data points are grouped by a label ("Line_ID"), which 
indicates the represented surface and the number of the stream longitudinal profile it belongs 
to (see resulting records at the bottom). 
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Fig. A6-40: Converting (grouped) profile points to profile lines. 
The "Line_ID" controls which points are aggregated to one line (e.g. all points of base level 
HDS belonging to stream profile 5). The sort field 'MEAS', representing the distance along 
the stream longitudinal profile, ensures that vertices of the resulting polylines are connected 
in the right order. 
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Fig. A6-41: Attribute table of the final line shapefile, representing elevation values of all surfaces 
along stream longitudinal profiles. 
After converting the points to lines, only the field "Line_ID" (red circle) is preserved, which 
contains the aggregated information about both the (represented) stream longitudinal profile 
number and the surface. By the 'Add Field' and the 'Field Calculator' function, these attributes 
are split again into two separate fields  ("RID": type long; "Surface": type string). 
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Fig. A6-42: Plotting stream longitudinal profiles (lines) in ArcGIS. 
The attribute "RID" stores the number of the stream longitudinal profile (LP) and can there-
fore be used in the "Definition Query" to select which LP to display. The attribute "Surface" 
is used as the value field in the symbology setting, to visually differentiate the different sur-
faces. 
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6.D Extracting topographic / geological profiles 

Introduction (summarised from section 3.6): 
Regional profiles across the study area were extracted in north-south and east-west direction. The 
sampling lines of the topographic profiles have been defined manually, accounting for interesting 
locations. Sampling points have been generated along the profile sampling lines at horizontal 
distances of 10 m. 

Apart from the present topography, the resulting profiles display the following information: 

• Base level of HDS 

• Base level of TDS 

• Top bedrock (where Quaternary deposits > 5 m) 

• Lithostratigraphic units of bedrock surface and projection at depth. 

• Landslides (schematic illustration) 

• Additional content (place names etc.) 

Subsections of the regional topographic / geological profiles were also used for interpretation and 
illustration of landslide process types in the study area (section 4.2). 

Data processing:  "Extraction of elevation values" 
The detailed working steps of extracting elevation values along the regional topographic / geo-
logical profiles in ArcGIS are listed in Tab. A6-14. 
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Tab. A6-14: Projection of sampling points (Topographic profiles (sampling points 10 m)) on pro-
file lines (Topographic profiles (routes)). 

 

Nr. Processing step Input dataset(s) ArcGIS 

1. Preprocessing input 
raster datasets for 
extraction of 
lithostratigraphic 
boundaries at depth 

Subsurface model NTB 14-02 Spatial Analyst Tools > Map 
Algebra > Raster Calculator 

(Details in Fig. A6-43) 

2. Manually defining 
sampling lines 

 Editing Tool > Create Features 

3. Creating sampling points 
along sampling lines (at 
regular distances of 10 m) 

Topographic profiles (sampling 
lines) 

Data Management Tools > 
Sampling > Generate Points 
Along Lines 

(analogous to Fig. A6-30) 

4. Extracting elevation 
values at sampling point 
locations 

Topographic profiles (sampling 
points 10 m) 

DTM-AV 

Base level of HDS 

Base level of TDS          (*) 

Top bedrock 

Basis Tertiary 

Basis Malm 
(Wildegg-Formation)      (**) 

Top Opalinus Clay 

Top Lias 

Spatial Analyst Tools > 
Extraction > Extract Multi 
Values to Points 

(Details in Fig. A6-44) 

5. Convert sampling lines to 
route elements (for linear 
referencing) 

Topographic profiles (sampling 
lines) 

Linear Referencing Tools > 
Create Routes 

(analogous to Fig. A6-32) 

6. Locating points along 
routes (measures distance 
of sampling points along 
the regional profiles) 

Topographic profiles (sampling 
points 10 m) 

Topographic profiles (routes) 

Linear Referencing Tools > 
Locate Features Along Routes 

(analogous to Fig. A6-33) 

(*) preprocessed according to Tab. A6-10 (HDS, TDS) and step 1 of Tab. A6-12 (Top bedrock) resp. 
(**) preprocessed according to Fig. A6-43 (step 1 of this table) 

 
 
  



NAGRA NAB 17-42 A6-48 
Appendix 6  
  

 

 

 

 

 

 

 

 

Fig. A6-43: Using Raster Calculator to preprocess input raster datasets for extraction of litho-
stratigraphic boundaries at depth (from "Subsurface model NTB 14-02"). 
"NoData" values in the raster dataset (here "Tiefenlage Basis Tertiär", corresponding to file-
name "BTe_union_20140930", Appendix 5.A) are thus replaced by -9999. This is required 
for the tool "Extract multi values to points" (Fig. A6-44) to be executed successfully. Ana-
logously, the procedure is repeated for "Tiefenlage Basis Malm", "Tiefenlage Top Opalinus-
ton" and "Tiefenlage Basis Opalinuston". 

 
 
 
 

 

 
 
 

 

 

 

Fig. A6-44: Extracting elevation values at sampling point locations. 
The selected input rasters correspond to: 1) DTM-AV (here "dtm_av_jo_clip"); 2) Base level 
of HDS; 3) Base level of TDS; 4) Top bedrock; 5) Basis Tertiary; 6) Basis Malm (Wildegg-
Formation); 7) Top Opalinus Clay; 8) Top Lias. Preprocessing as referrenced in Tab. A6-14, 
step 4. 
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The output of the processing steps in Tab. A6-14 is a txt-file containing elevation values and 
distance of sampling points along the regional topographic / geological profiles. The table has 
been exported and processed in Excel as "Topographic profile table" 7. 

In addition to Tab. A6-14, also the "lithostratigraphic boundaries" at surface (as displayed in 
Appendix 1.C) have been intersected with the sampling lines of the regional profiles 
(Tab. A6-15). This is used as additional reference for the final illustration of lithostratigraphic 
units in Appendix 4. 

Tab. A6-15: Intersection points of topographic profiles (sampling lines) and lithostratigraphic 
boundaries at surface.  

 

Nr. Processing step Input dataset(s) ArcGIS 

1. Create intersection points Lithostratigraphic boundaries 

Topographic profiles (sampling 
lines) 

Analysis Tools > Overlay > 
Intersect 

2. Extracting elevation 
values (present 
topography) at intersection 
points 

Intersection points of 
topographic profiles and 
lithostratigraphic boundaries at 
surface 

DTM-AV 

Spatial Analyst Tools > 
Extraction > Extract Multi 
Values to Points 

(analogous to Fig. 44) 

3. Locating points along 
routes (measures distance 
of sampling points along 
the regional profiles) 

Intersection points of 
topographic profiles and 
lithostratigraphic boundaries at 
surface 

Topographic profiles (routes) 

Linear Referencing Tools > 
Locate Features Along Routes 

(analogous to Fig. 33) 

 
The output of the processing steps in Tab. A6-15 is a txt-file containing elevation values, names 
of lithostratigraphic boundaries and distance of sampling points along the regional topographic / 
geological profiles. The table has been exported and processed in Excel as "Topographic profile 
table (intersection points of topographic profiles and lithostratigraphic boundaries at surface)" 8. 

Analogous to Fig. A6-34 (stream profiles), elevation values are scaled in the Excel tables by factor 
10, to accentuate variations of local relief in the resulting illustrations (Appendix 4).  

Data processing: "Profile construction" 
Based on the resulting Excel tables above, the regional topographic / geological profiles have 
been displayed in analogy to the procedure described for the stream longitudinal profiles 
(Tab. A6-13, and Fig. A6-35 etc.).  This involved the creation of various shapefiles in ArcGIS 
that do not represent "real" geographic datasets and have therefore not been included in Appen-
dix 5.B. However, the shapefiles can be found via filepath: …/Data/Profile_Construction_Topo_ 
Profiles/ in the NAB 17-42 directory. 

                                                           
7  Filepath within directory NAB 17-42: …/Data/Profile_Construction_Topo_Profiles/Topo_Profiles_JO_Output_ 

Event_Table.xlsx 
8  Filepath within directory NAB 17-42: ...Data/Profile_Construction_Topo_Profiles/Topo_Profiles_Litho_Surface_ 

JO_Output_Event_Table.xslx 
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Since the lithostratigraphic boundaries at depth were not included in the first draft, the extracted 
surfaces are found in two separate shapefiles ("Topo_Profiles_JO_10x_All_Surfaces 
_Data_Points.shp" and "Topo_Profiles_JO_10x_Litho_Layer_Points.shp"). 

Also, the lithostratigraphic boundaries at depth ("Topo_Profiles_JO_10x_Litho_Layer 
_Points.shp") were not further converted into a polyline shapefile. Instead, the lines were drawn 
manually (and simplified) in Adobe Illustrator, based on the data points and the projected 
"intersection points of topographic profiles and lithostratigraphic boundaries at surface" 
("Topo_Profiles_JO_10x_Litho_Intersection_Points.shp").  

Apart from those point and polyline shapefiles with vertical axis scaled by factor 10, some 
shapefiles were also created without rescaling. These were used to create the geological cross 
sections (interpretation of landslide process types) in section 4.2 of the main report: 

• "Topo_Profiles_JO_DTM_AV_Lines.shp" 

• "Topo_Profiles_JO_Top_Bedrock_Data_Points.shp" 

• "Topo_Profiles_JO_Litho_Intersection_Points.shp" 
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